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1 Preamble 

A rolling bearing damage of an industry gear box is expensive. Mostly not only the rolling bearing has to be 
replaced. The toothing is also damaged if the rolling bearing damage has lead to a displacement of the 
shaft. These elements have to be purchased. There will also arise working hours of the installing person. 
Then there will also arise costs of the production loss. But if you recognize the rolling bearing damage early 
enough consequential damages can be prevented and the repair can be made during a planned stoppage. 
Production losses are prevented extensively. 
The Peakanalyzer can not prevent damages but it enables automatically recognition of damages in the 
beginning and automatic alerting. 

• Cost-intensive, low redundancy drives like mills in the cement industry 

• Drives with a particular relevance of availability like drives of the conveyance system, 

• Especially security relevant drives like drives of cable trains and 

• Drives like wind energy turbines which have to be stringently subject to a predictive maintenance 

because they are e.g. hardly accessible. 

The Peakanalyzer enables 

• The automatic vibration diagnostic on up to 16 measuring points and alarm only if irregularities are 

detected, 

• The process factor monitoring on up to 4 measuring points, 

• The rain flow classification of up to 2 process variables, 

• Particle counting in the lubricant at 2 counter inputs, 

• Base monitoring of Wind Turbine Generators 

• The logging of the asset history of the drive for a later determination of failure causes as also 

• The possibility to make service measurements, independent of the automatic vibration diagnosis 

without the possibility to read stored data of the automatic vibration diagnosis. 

The Peakanalyzer is constantly installed at the drive. Once started it works steadily with a minimum of effort 
for the system maintenance. 
The control of one or multiple Peakanalyzer is made with the program Peakanalyzer Manager. 
The kinematics data which arise from the construction have to be set at the Peakanalyzer in a monitoring 
configuration. Out of it the Peakanalyzer calculates automatically the relevant 
kinematics frequencies and orders. 
The evaluation of the amplitudes occurs automatically according to a patented universal mathematic 
method. So it is not necessary to set limit values for the amplitudes. Consequently 
there do not exist uncertainties which exist at other systems by setting subjectively amplitude limit values. It 
is also no learning process necessary. 
Loading a configuration monitoring, handling alarms, the sifting of data and the implementation of service 
measurements can be performed directly on the Peakanalyzer by connecting a 
computer via Ethernet or via modem. The Ethernet port provides the ability to connect with the 
Peakanalyzer from different router via DSL, ISDN, GSM, UMTS or LTE. 
 
We wish our customers that the Peakanalyzer proves to be an useful tool for the predictive maintenance. 
We would appreciate to receive suggestions which would lead to an improvement of the Peakanalyzer or 
the present manual. 
 
Now we would like to offer the seminars of GfM Gesellschaft für Maschinendiagnose mbH in which you get 
to know the basics of machine diagnosis. These basics are helpful for working with the Peakanalyzer 
especially for the configuration and interpretation of diagnostic data. 
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GfM Gesellschaft für Maschinendiagnose mbH 
Köpenicker Straße 325, Haus 40 
12555 Berlin (Germany) 
Tel  +49 30 / 6576 2565 
Fax  +49 30 / 6576 2564 
Internet  www.maschinendiagnose.de 
E-Mail  mailbox@maschinendiagnose.de 
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2 Introduction 

This manual describes the installation, configuration and usage of the software Peakanalyzer Manager. 
The Peakanalyzer Manager can manage an arbitrary number of Peakanalyzer in the network. 
Via the Peakanalyzer Manger a diagnostician can communicate with the Peakanalyzer and control it. It 
allows to: 

• create monitoring configurations and transmit them to the assigned Peakanalyzer 

• view and evaluate the data that is generated on the Peakanalyzer during the monitoring 

• handle alarms that are generated on the Peakanalyzer 

• do service measures 
Additional features like marking diagnosis attributes, filter the data and usage of trend visualization makes it 
easier to diagnose . 
Installed Peakanalyzer on machines or engines can be structured in an hierarchical and well observable 
view with the Peakanalyzer Manager. 
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3 First Steps 

3.1 System requirements 

For the usage of the Peakanalyzer Manager is a PC with latest drivers required that fulfill the following 
system requirements: 
 
Minimum: 

• Windows 7 

• RAM: 4 GB 

• Processor: 2 x 1.6 GHz 

• Graphic: 256 MB RAM 
 
Recommended: 

• Windows 7, Windows 8, Windows 10 

• RAM: 8 GB 

• Processor: 4 x 2 GHz 

• Graphic: 512 MB RAM 

3.2 Installation 

The following operation systems are supported: 

• Windows 7 

• Windows 8 

• Windows 10 
 
For the installation of the Peakanalyzer Manager the installation CD must be put in a suited drive in the PC. 
If the installation program does not start automatically, the installation can be started by manually executing 
the file PM_Setup.exe on the installation CD. Administrator privileges are required for the installation 
process. 
 
It is advised to follow the instructions during the installation process. It is recommended to install the 
program Peakanalyzer Manager in the proposed directory.  
 
The installation program will check whether up to date versions of .NET Framework and DirectX 9.0c are 
installed on the PC. If necessary theses programs will be updated. 
 
Also a free version of the Microsoft® SQL Server® 2012 Express will be installed on the PC. It serves as 
data storage for measured and evaluated data that are generated on the Peakanalyzer. The free version of 
the Microsoft® SQL Server® 2012 Express supports 10 GB of data storage for each Peakanalyzer. This 
suits for a standard configuration for measurement data of approximately 2 years. If a configuration is used 
with a smaller storage interval or the measurement data in the Peakanalyzer Manager should be available 
more than 2 years, it is highly recommended to use a product line of the Microsoft® SQL Server® that does 
not have the 10 GB limitation per database. 
 
After the installation there is link of the Peakanalyzer Manager in the program group GfM in the start menu. 

3.3 Network Settings 

To establish a connection to the Peakanalyzer the network settings of the PC may be adopted. The 
Peakanalyzer must be in the same subnet as the Peakanalyzer or an active route to the subnet of the 
Peakanalyzer must be present. 
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4 General 

4.1 Language 

After the first start of the Peakanalyzer Manager the language is set according to the language settings of 
the operating system. If the operating system is set to German, the Peakanalyzer Manager will start in 
German. Otherwise language is chosen.  
 

In the menu Extras → Options the language can be changed on the tab language. To apply these changes 
the program Peakanalyzer Manager must be restarted.  

4.2 SQL-Server Settings 

To work properly with the Peakanalyzer Manager, a connection to a Microsoft® SQL Server® 2012 must 
be present. If the Peakanalyzer Manager was installed with default settings, the connection to the installed 
Microsoft® SQL Server® 2012 Express was automatically configured.  
It is also possible to use a Microsoft® SQL Server® 2012 that is installed on another PC in the local net. 
Thus multiple PCs in the same network can have installed the Peakanalyzer Manager and use all the same 
database server.  
The connection to a Microsoft® SQL Server® 2012 can be changed during runtime by entering the SQL 

server name and login credentials in the menu point Extras → SQL-Login. 
 

 
 

Furthermore multiple user on this SQL-Server can be configured in the menu Extras → SQL-Settings to 
allow individual access for different persons. This setting is only available for administrators. 
The following access rights are available: 

• Administrator: can add further users 

• Standard user: can do all actions except adding new user 

• Read-Only user: can only view and export data and configurations. 

• Restricted user: has same rights as read-only user but can do measurements of PeakStore devices as 
well as export and delete these measurements 

 
Additionally users can be deleted and passwords of other users can be changed.  
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If the login data of the installed Microsoft® SQL Server® 2012 Express are lost, it is possible to login with 
the following SQL login data: 
Username: sa 
Password: P@s$w0rdP@s$w0rd 

It is highly recommended to immediately create a new administrator in the menu Extras → SQL Settings 

and relogin with the new user via Extras → SQL Login. 

4.3 Program Overview 

There is a tree view on the left side of the Peakanalyzer Manager which can be nested arbitrary deep by 
the user. It serves as an overview for the monitored machines and engines. In this view multiple 
Peakanalyzer can be added in each layer. The state of the underlying layers is visualized by the color of 
the node. 
If there is an alarm on one Peakanalyzer, the node of the Peakanalyzer and all parent nodes are colored 
red. If all alarms are handled, the node will be colored green. 
 

View 

 
The view of the hierarchical structure can be switched between the modes monitoring and measurement 
devices. In the view measurement devices the Peakanalyzers are faded in. Only in this view it is possible to 
do the following actions: 

• query properties of the Peakanalyzer, like: 

o read hardware equipment 

o view and update license information 

o view and change IP settings 

o view and change access rights 

o query the online state of the current monitoring state 

• view, change, save and transmit configurations of the Peakanalyzer 

• do a service measure based on the current monitoring configuration 
 
The Peakanalyzer is faded out in the monitoring view. Therefore a pure view on the state of the monitored 
machines is possible.  
If one or multiple machines are monitored by one Peakanalyzer, these are listed in the measurement 
devices view below the Peakanalyzer. In the monitoring view these machines are listed below the higher 
level layer.  
Furthermore multiple Peakanalyzer can be configured to monitor one machine. This machine would occur 
multiple times In the measurement devices view, namely in each Peakanalyzer that monitor this machine. 
In the monitoring view this machine occur only once and all data off all Peakanalyzer are merged together. 
If multiple machines are monitored by one Peakanalyzer, they are listed under the Peakanalyzer in the 
measurement view. In the monitoring view they are listed below the higher level layer. 
 

For the measurement devices view the display can be modified. In the menu View → Display it can be 
chosen between the following one: 

• name of the Peakanalyzer 

• name of the configuration 

• location 
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The name of the Peakanalyzer is the default option.  
 
Furthermore it is possible to move the hierarchical layers per Drag & Drop. This can be enabled by 

activating the menu View → Modify hierarchy. 

4.4 Add Peakanalyzer 

A new Peakanalyzer can be integrated in the system by selecting diagnosis system → New → 
Peakanalyzer in the menu or context menu in the hierarchical tree view. The Peakanalyzer will be added to 
the current selected hierarchical layer. 
 

 
 
The local network can be searched for existing Peakanalyzer. If one Peakanalyzer is taken, all needed 
settings will be set. If the Peakanalyzer is not in the list, the settings can be set manually. 
 
The following information are required: 

• Device name of the Peakanalyzer: The name has the following schema: CX-123ABC. This information 
can be found on the Peakanalyzer 

• Location: An optional description for the location of the Peakanalyzer 

• IP-Address of the Peakanalyzer 

• Alternatively a network name can be set. This network name must be resolved to the correct IP-
Address of the Peakanalyzer by an name server 

• Port for the communication to the Peakanalyzer: Furthermore the following 4 ports are used for the 
communication to the Peakanalyzer. The default ports are 8521-8524 

• Database name: The database name is set automatically when the device name is changed and 
usually must not be changed. 

4.5 Bearing database 

Under the menu point Templates → Bearing Database a repository of bearing types can be created. The 
required information can be generally obtained from the bearing manufacture. The configured bearing 
types can than be used in machine configurations, e.g. on the Peakanalyzer. Thus the bearing information 
can be maintained on a central and the amount of erroneous inputs during the kinematic configuration is 
reduced. 
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This bearing database can also be exported to a separate file for porting on another Peakanalyzer 
Manager or to backup the current database.  
If the Peakanalyzer Manager and the corresponding SQL database is newly installed on a system, the 
bearing database is initially empty. The GfM Gesellschaft für Maschinendiagnose mbH does not provide a 
bearing database for liability reasons. The bearing database must be created and maintained by the user 
itself. 
If multiple Peakanalyzer Manager in the same network use the same SQL database and multiple user edit 
the bearing database simultaneously, it is possible that changes to bearings that are already edited by 
another user are withdrawn. In this case an appropriate message is shown.  

4.6 Machine templates 

Under the menu point Templates → Machine templates complete drive chains can be managed. This is 
helpful if multiple machines of the same type are monitored by different systems. Thus the machine type 
must be only created once as template and can then be applied to the actual machine. By pressing the 
button "Add machine template" a new template can be created. The name of the template can be directly 
edited in the left list. Now the complete drive chain can be configured for this created machine template. 
Details for the different available drive elements can be found in the chapter drive elements. The configured 
machine template can the be used by e.g. the configuration of a Peakanalyzer. 
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5 Peakanalyzer 

5.1 Properties 

The properties of the Peakanalyzer can be queried by selecting the menu point "Diagnosis system" → 
Properties or the button Properties in the navigation bar at the bottom. For this action an active LAN 
connection to the Peakanalyzer must be established. During the query process the device name of the 
Peakanalyzer on the device and in the local database will be verified. If they do not match, the device name 
in the local database can be adjusted to the correct device name. 

5.1.1 Hardware Equipment 

 
 
An the tab hardware equipment the automatically detected in- and output channels of the Peakanalyzer are 
listed. The button Rescan forces the Peakanalyzer to rescan the hardware equipment. This can be useful if 
the Peakanalyzer is extended by additional in- or output channels or when the expected hardware 
equipment does not match with the listed. By clicking on the button an additional warning appears that the 
Peakanalyzer needs to restart to run the hardware scan. This procedure can take 5 - 10 minutes. During 
this time the Peakanalyzer is not available via the Peakanalyzer Manager. When the procedure is finished 
the properties can be queried again to verify the new hardware settings. 
 
Furthermore the stored license information can be seen on this tab. These license information are checked 
during the normal monitoring to ensure that the maximum amount of configured channels for machine 
diagnosis does not exceed the licensed number of channels. On each Peakanalyzer, delivered by GfM 
Gesellschaft für Maschinendiagnose mbH, is already the ordered number of diagnosis channels licensed. If 
the existing Peakanalyzer should be extended, the license can also be extended. The button "update 
license" allows to select and store a new license on the Peakanalyzer. The settings are applied 
immediately and the contained number of diagnosis channels are listed. Detailed information about the 
licensing are provided at an extension of the Peakanalyzer.  
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5.1.2 System 

 
 
On the tab system is the network configuration of the Peakanalyzer listed. By clicking on the button Change 
the network settings of the Peakanalyzer can be modified. A new window will open where the following 
information can be set: 

• Resolve IP Address automatically The Peakanalyzer requests the network configuration from an 
existing DHCP-Server 

• IP-Address 

• Subnet mask 

• Gateway 

• DNS-Server 

• NTP-Server If an NTP-Server is configured, the Peakanalyzer will synchronize to the time server once 
an hour. 

• Ports TCP and UDP Ports for the communication to the Peakanalyzer 
 
Furthermore the current firmware version of the Peakanalyzer will be displayed. If the firmware of the 
Peakanalyzer does not match with the stored firmware in the Peakanalyzer Manager, the firmware can be 
updated.  

5.1.3 Access Rights 
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On the tab access rights individual privileges for multiple user for the access on the Peakanalyzer can be 
configured. These are saved on the Peakanalyzer and will be queried on each access to the Peakanalyzer. 
The following access rights can be set: 

• Administrator has all other rights and can add, delete or modify all other users 

• Change configuration Allows to transmit and modify the configuration on the Peakanalyzer 

• Service measure Allows to do a service measurement based on the current monitoring configuration 

• Acknowledge alarms Allows to acknowledge or reset the current alarms on the Peakanalyzer 

• Read data Allows to read the saved measurement data and alarm notifications on the Peakanalyzer 

• Delete data Allows to delete measurement data directories on the Peakanalyzer 
 
By default the user admin (with password: admin) is pre-configured on the Peakanalyzer. It is 
recommended to change this password. 

5.1.4 Online Status 

 
 
The current executing task of the monitoring process can be seen on the tab "Online Status". Thus it is 
possible to trace, whether the Peakanalyzer works correctly.  
The following steps can be seen: 
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• Check Preconditions 

• Measure 

• Analyze 
 
If the Peakanalyzer has a Profibus-Slave terminal or a Profinet-Device terminal equipped, the error state of 
the corresponding terminal can be queried. The state is queried when the button update is pressed. 

5.2 Configuration 

In this chapter the configuration of a Peakanalyzer for monitoring one or multiple machines is described. If 
the hardware equipment of the Peakanalyzer is known beforehand, the configuration can be created 
without an active connection to the Peakanalyzer. Only for transmitting the configuration on the 
Peakanalyzer an active connection is required again. An access to the configuration is only available if the 
Peakanalyzer is selected on the left tree view.  
 

New Configuration 

 
If the hardware equipment is known beforehand a new configuration for monitoring engines and machines 

can be created via the menu point Configuration → New. If the hardware equipment is not known, a 
connection to the Peakanalyzer will be established to download it. The new configuration will be filled with 
useful default settings.  
 

Load Configuration 

 

Via the menu point Configuration → Load the current configuration from the Peakanalyzer, the last modified 
configuration or a previously transmitted configuration can be loaded. 
 

Import Configuration 

 

Via the menu point Configuration → Import the configuration of another Peakanalyzer can be applied to the 
currently selected one. This only works if both Peakanalyzer have the same hardware equipment. 
 

Export Configuration 

 

Via the menu point Configuration → Export the selected configuration can be saved as a file. This can be 

imported on another Peakanalyzer Manager by Diagnosis system → Import. Alternatively the configuration 
can be exported as pdf file. 
 

Save Configuration 

 

Via the menu point Configuration → Save the current monitoring configuration can be saved in the local 
database. This configuration can be transmitted to the Peakanalyzer afterwards or can be edited again at a 
later time point. 
 

Transmit Configuration 
 

Via the menu point Configuration → Transmit the current configuration on the Peakanalyzer will be stopped 
and saved as a backup on the Peakanalyzer. Afterwards the new configuration will be transmitted to the 
Peakanalyzer and started afterwards. 
 

Start Monitoring 

 
If the current configuration on the Peakanalyzer is stopped, it can be restarted via the menu point 

Configuration → Start Monitoring. 
 

Stop Monitoring 
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If the regular monitoring process should be stopped on the Peakanalyzer, the menu point Configuration → 
Stop Monitoring can be chosen to stop the current configuration. Thus the Peakanalyzer does not measure 
or analyze any data any more. This can be useful for a longer downtime of the monitored engine or 
machine. If a service measurement is initiated by the Peakanalyzer Manager on the Peakanalyzer, the 
configuration will also be stopped.  
 
The configuration parts are described in the subsequently following sections. 
  



Peakanalyzer Manager Manual 
 
 
 

 

20 / 108 

 

5.2.1 General 

On the tab General the following settings can be made: 
 

 
 

Name of configuration 
 
An arbitrary alphanumeric name. This name can be displayed in the left tree view instead of the name of 
the Peakanalyzer.  
 
 

Diagnosis sensitivity advanced diagnosis 
 
The sensitivity for the advanced diagnosis of the system can be controlled by the diagnosis sensitivity. This 
is equivalent to the number of detections in series before a kinematic alarm notification is generated. A low 
number of detections in series (high sensitivity) leads faster to notifications but also increases the risk of 
false notifications. A high number of detections in series (low sensitivity) accordingly leads to better verified 
notifications. Thus a notifications is generated later on the Peakanalyzer. Normally values from 3 to 5 
detections in series are a reasonable setting. 
 

Diagnosis sensitivity process factors 
 
The sensitivity for the process factors of the system can be controlled by the diagnosis sensitivity. This is 
equivalent to the number of detections in series before a process factor warning or alarm notification is 
generated. A low number of detections in series (high sensitivity) leads faster to notifications but also 
increases the risk of false notifications. A high number of detections in series (low sensitivity) accordingly 
leads to better verified notifications. Thus a notifications is generated later on the Peakanalyzer. 
 

Diagnosis sensitivity characteristic values 

 
The sensitivity for the characteristic values of the system can be controlled by the diagnosis sensitivity. This 
is equivalent to the number of detections in series before a warning or alarm notification of characteristic 
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values is generated. A low number of detections in series (high sensitivity) leads faster to notifications but 
also increases the risk of false notifications. A high number of detections in series (low sensitivity) 
accordingly leads to better verified notifications. Thus a notifications is generated later on the 
Peakanalyzer. 
 
Single Failure Mode 
 
If this mode is activated, it is first searched for indications on imbalance, misalignment, gear damages or 
loose particles in the advanced analysis. Peaks in the spectrum that matches to these patterns are not 
used for indications of bearing damages. This mode is recommended for the configuration. 
 

Monitor over-voltage protection 
 
Commonly the Peakanalyzer is equipped with an over-voltage protection for the network supply. If this 
over-voltage protection has an additional defect signal, it can be monitored by a digital input of the 
Peakanalyzer. The Peakanalyzer checks cyclically whether the over-voltage protection works appropriately 
and writes a corresponding notification in the logbook. 
 

Monitored machines 

 
The monitored machines must be set in the Peakanalyzer. A new machine can be added to the monitoring 
configuration by clicking on "Add new machine". There must be at least one machine added to the 
configuration. It is also possible to add multiple machines. 
Furthermore machines can be added that are already monitored by other Peakanalyzers. The monitoring of 
this machine is then extended by the sensors of the current Peakanalyzer. 
If one machine is deleted from the monitoring list and there are still drive elements connected to this 
machine, all connected drive elements will be deleted. 
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5.2.2 Inputs 

5.2.2.1 Bus Channels 

If the Peakanalyzer has a Profibus-Slave or a Profinet-Device, the according bus can be configured for 
additional input channels. These input channels can than be used as process channels or speed channels 
in the configuration. There can be up to two Profibus-Slave and two Profinet-Device terminals in one 
Peakanalyzer. The further configuration identifies the channel by its name. For example the "Profibus 2 
Channel 1" is the first channel of the second Profibus-Slave. 
 
The telegram that is received via the bus is defined by the following table. The amount and type of defined 
channels determines the size of the telegram. The first two bytes of the telegram are used for an input 
identification. Only if the given input identifier is written in the telegram the following information are 
evaluated. 
Each channel can be additionally multiplied with the scale factor, e.g. for scaling an integer value to an 
floating point range. Each channel can be configured with individual data types of the format 16 Bit Integer, 
32 Bit Integer, 32 floating point or 64 Bit floating point. All data must be written in BigEndian format on the 
Master/Controller side.  
 
Additionally one channel can be configured for alarm acknowledgment. By writing to this channel on the 
master/controller side it is possible to acknowledge all alarms of a given type on the Peakanalyzer. The 
alarm acknowledge must be written for at least one second. The following bit pattern must be used: 
 

Bit Description 

1 fixed value 1 

2 fixed value 0 

3 1 for alarm acknowledgment, otherwise 0 

4 1 for alarm reset, otherwise 0. Only Bit 3 or 4 must be set. 

5 fixed value 0 

6 1 for acknowledgment of kinematic alarms 

7 1 for acknowledgment of characteristic value alarms 

8 1 for acknowledgment of process factor alarms. Bits 6-8 can 
be set together. 

9-16 Percent value for alarm increase in the range 0-100 % 

 
Exemplary follows a configuration with 3 input channels: 

• 1st Channel: 32 Bit Floating Point 

• 2nd Channel: 32 Bit Integer 

• 3rd Channel: 16 Bit Integer 
 
The telegram will then be the following: 
 

Byte Description 

1 - 2 Input-Identification 

3 - 6 32 Bit Floating Point Value of 1st Channel 

7 - 10 32 Bit Integer Value of 2nd Channel 

11 - 12 16 Bit Integer Value of 3rd Channel 

 
Thus the telegram consists of 12 Bytes or 6 Word. 
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Profibus Channels 

 
 

To use the Profibus for input channels the check for "Activate Input" must be set. Furthermore the Profibus-
Slave-Address must be set that is agreed with the Profibus-Master.  
Afterwards the configuration of the input channels is done as described in Bus Channels.  
 
After transmitting the configuration the Profibus-Slave will be configured with the defined telegram in big 
endian format. 
This telegram must be also defined on the corresponding Profibus-Master. In the program directory of the 
Peakanalyzer the GSD file of the Profibus-Slave can be found which maybe is needed for configuring the 
Profibus-Master. 
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Profinet Channels 

 
 
To use the Profinet-Device for additional input channels, the check "Activate Input" must be set. 
The MAC-Address of the Profinet-Device is provided on this site for the correct configuration of the 
Profinet-Device. Furthermore the last 4 numbers of the Profinet station name can be modified to avoid 
name conflicts with other devices. 
Afterwards the configuration of the input channels is done as described in Bus Channels.  
 
After transmitting the configuration the telegram with the defined size is applied on the Peakanalyzer. The 
telegram size of the Profinet-Device is always round up to the next power of two. Thus there are only 
telegrams of the size 1, 2, 4, 8, 16, 32 or 64 WORD. The data is always transmitted in Big Endian format. 
The telegram structure must be configured on the Profinet-Controller in the same manner. The GSDML file 
of the Profinet-Device that may be neccessary for the configuration of the Profinet-Controller can be found 
in the program directory of the Peakanalyzer Manager.  
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5.2.2.2 Speed Channels 

The speed channels can be configured on this tab. 
 

 
 
For the measurement of the speed information, different physical input channels can be used. The 
following are available: 

• Speed Channels Up to 4 Incremental-Encoder-Inputs can be configured on each Peakanalyzer. They 
work with a very accurate impulse time point measurement method. This also delivers very accurate 
speed information if multiple non-equidistant impulses are placed per revolution. This is the 
recommended mode. 

• DC-Channels The speed information can also be applied as voltage input (10 V) on an analog input 
channel. Thus the given voltage value is directly converted into a speed information. 

• Fixed Speed If there is no external speed information available and the monitored machine operates 
with a constant speed, the fixed speed value can be given in this mode.  

 
Properties speed processing 
 
Some additional properties must be set for the different channel types: 
 
Speed Channel: 

• Number of impulses per revolution 

• minimal and maximal speed where an analysis should take place. This is required to determine an 
optimal measurement time for the monitoring of certain drive elements later on.  
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• Activate counter channel: If the speed is connected via A/B lane, the position value can be measured 
as process factor. After activation the counter channel is available in the process channels section. 

 
DC-Channel: 

• Sensitivity in 1/min / V for the calculation of the speed value from the voltage value 

• Offset if the voltage 0 V does not match to 0 1/min 

• minimal and maximal speed where an analysis should take place. This is required to determine an 
optimal measurement time for the monitoring of certain drive elements later on.  

 
Fixed Speed: 

• Speed which is used for the calculation of order spectra from the frequency spectra. 

5.2.2.3 Counter Channels 

Counter channels for example for counting metal particle can be configured on this tab. 
 

 
 
The following settings have to be set for the configuration of one counter channel: 

• Name an arbitrary alphanumeric name for the description of measurement position 

• Channel the physical input channel where the counter is connected to.  

• Warn threshold Absolute If this absolute threshold value is exceeded a warn entry in the logbook is 
generated 

• Alarm threshold Absolute If this absolute threshold value is exceeded an alarm is generated 

• Warn threshold Hour If this hourly based threshold value is exceeded a warn entry in the logbook is 
generated 

• Alarm threshold Hour If this hourly based threshold value is exceeded an alarm is generated 

• Warn threshold Day If this daily based threshold value is exceeded a warn entry in the logbook is 
generated 

• Alarm threshold Day If this daily based threshold value is exceeded an alarm is generated 
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• Machine assignment The counter channel can be assigned to one or multiple machines that are 
configured in the Peakanalyzer. By default all machines are assigned to the counter channel.   

5.2.2.4 Vibration Channels 

The input channels for vibration acceleration and vibration distortion sensors, that are used for the 
diagnosis and specific value generation, can be configured on this tab. 
 

 
 
The following settings have to be set for the configuration of one sensor: 

• Name an arbitrary alphanumeric name for the description of measurement position 

• Channel the physical input channel where the sensor is connected to. This can be a current driven 

IEPE-Channel for accelerometers in the measurement range 5 V or a DC-Channel for distortion 

sensor in the measurement range 10 V. 

• Reference Speed A speed channel that was configured on the tab speed channels to generate order 
spectra from the time signal with this reference speed 

• Sensitivity / V The sensitivity of the connected sensor. This information can be obtained from the 
sensor data sheet or a related calibration certificate. 

• Offset The offset of the connected sensor. This information can be obtained from the sensor data sheet 
or a related calibration certificate.  

• Unit The unit of the physical quantity that the sensor measure. This is "m/s^2" for accelerometers and 
"m" for distortion sensors. 

• Lower cut-off frequency Kinematic patterns of the advanced diagnosis are not searched below this set 
frequency. Default: 0 Hz 

• Highpass Envelope The highpass filter for the calculation of the envelope signal can be individually 
adjusted. Default: 2kHz 

• IEPE current feed If a IEPE-Channel is selected, the current feed can be chosen of the values 2, 4 or 8 
mA which is relevant for long sensor cables. Default: 2 mA 

• Measurement Time [s] The measurement time or measurement times that are configured for this 
sensor. For Peakanalyzer SE the measurement time for the sensor must be configured with one of the 
given pool. In the normal version this serves only as an overview. The measurement time for the 
sensors is determined while assigning the drive elements to a sensor. 

 
The following information are educed from the aboves or serve as additional information and are configured 
on a different tab: 

• Measurement Range This results from the selected input channel (IEPE or DC), sensitivity and offset of 
the sensor and the selected unit. The measured time signals can lie in this measurement range. 

• Sampling frequency [Hz] The sampling frequency of the reduced time and envelope time signals that 
are saved for this sensor. 
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• max. frequency The maximum frequency that is contained in the resulting frequency and envelope 
frequency spectra. 

5.2.2.5 Virtual Process Channels 

On this tab virtual process channels can be created by the online calculation of two channels. The 
generated channel can the be selected in the channel column on the process channel tab and further 
configured as described in process channels.  
 

 
 
For the first and second channel all channel types are available that are available for the normal process 
channels and speed channels. The speed channel with incremental encoder interface (EL5151) must not 
be used if the signal is connected to clamp C. Only if the signal is connected to the A or A/B spur, the 
channel may be used for online calculation. 
To each channel a multiplicative factor and an additive offset can be added. These two channels can be 
calculated to one new channel by the chosen basic arithmetic operation. The resulting channel can then be 
configured as any other process channel on the tab process channels. The chosen sampling frequency is 
then automatically applied to both channels.  
It must be ensured by the user that the resulting virtual channel is configured with a resulting meaningful 
unit. The configurable unit on the tab process channels is applied to the resulting channel.  
 
One concrete scenario for the usage of virtual process channels is the base monitoring of wind turbines 
(Product: Baseanalyzer). There a distortion sensor measures the movement between the base and the 
steel tube tower. An additional strain gauge measures the strain of the steel tube tower. The recalculation 
of the two inputs allows to monitor the actual movement between the base and the steel tube tower. 
 
For example a distortion sensor at DC-Channel 1 with measurement range 3..13 mm and maximal output 
voltage of 10 V is used for the measurement of the distortion of the base. Furthermore a strain gauge 
(DMS-Channel 1) is applied on the steel tube tower. The strain gauge delivered by GfM has a maximum 
measurement voltage (UM) of 25 mV with a supply voltage (UV) of 5 V and a gage factor of k = 2.1 at 24 °C. 

Thus a relative length change  can be calculated as follows: 
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With the above mentioned data a relative length change  is calculated to about 0.0037 m/m ( = 3,7 

mm/m). If the foundation component has a length of 3 m the length change is 11 mm at 25 mV 
measurement voltage UM and therefore the sensitivity is 440 mm / V.  
 
The configuration for the virtual channel is then parametrized as followed: 
 
Factor 1:  1 (mm / V) 
Channel 1:  DC-Channel 1 
Offset 1:  3 (mm) 
 
Operand:  Subtraction 
 
Factor 2:  440 (mm / V) 
Channel 2:  DMS-Channel 1 
Offset 2:  0 (mm) 
 
It is reasonable to additionally configure the strain gauge as a separate process channel. The service 
measurement provides the possibility to zero balance these configured strain gauge. This will save a 
configuration independent offset in the strain gauge box. The zero balancing in the service measurement 
should be only done if the steel tube tower is in normal position. 

5.2.2.6 Process Channels 

 
 
Process channels can be used to continuously measure process information. This can be e.g. power or 
temperature. These information can also be used to further restrict the analysis on certain operating point.  
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The following signals can be measured: 

• analog voltage input 10 V 

• analog current input 0..20 mA 

• Strain Gauge 25 mV 

• PT-100 Temperature sensors 

• Digital Input 

• digitalized signals via Profibus 
 
First of all the physical quantity must be parametrized. Therefore the following parameters must be set: 
 

• Name an arbitrary alphanumeric name for the connected process information (e.g. temperature) 

• Channel the used analog input channel 

• Sampling frequency sampling frequency of the analog channel selectable between 1 Hz and 1 kHz  

• Storage interval selectable between 1 s and 99 min depending on the selected sampling frequency 

• Sensitivity / V and Offset Conversion of the voltage value to the process information 

• Unit an arbitrary description for the physical unit (e.g. °C) 

• Measurement range This is calculated automatically by the given sensitivity, offset and unit 

• Machine assignment The process information can be assigned to one or multiple machines that are 
configured in the Peakanalyzer. By default all machines are assigned to the process channel.   

 
The processing of the configured process channels is done in the next section: process factors.  
 
 
Note: The sampling of the process channels is done without anti-aliasing and therefor can not be used for 
analysis in the frequency domain. 
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5.2.3 Base Diagnosis 

5.2.3.1 Characteristic Values 

 
 
On this tab the r.m.s. value of the vibration velocity and of the vibration acceleration can be set for the 
configured sensor channels.  
The following parameters must be set for one sensor: 

• Sensor Selection of a sensor that was configured in sensor channels 

• Characteristic Value 

o DIN-ISO 10816-3 in vibration velocity or vibration acceleration: This characteristic value is 
calculated from the reduced time signal with the configured shorter measurement time and has 
the frequency bandwidth as stated in the vibration channels section. 

o DIN-ISO 10816-21 0,1 Hz - 10 Hz in vibration velocity or vibration acceleration with an 
evaluation period of 10 min 

o DIN-ISO 10816-21 10 Hz - 1 kHz in vibration velocity or vibration acceleration with an 
evaluation period of 1 min 

o DIN-ISO 10816-21 10 Hz - 2 kHz in vibration velocity or vibration acceleration with an 
evaluation period of 1 min 

o DIN-ISO 10816-21 10 Hz - 5 kHz in vibration velocity or vibration acceleration with an 
evaluation period of 1 min 

o Online r.m.s. of vibration velocity with 10 Hz high pass filter and adjustable low pass filter 

o Online r.m.s. of vibration acceleration with adjustable low pass filter 

o Online r.m.s. of vibration acceleration of envelope with adjustable low pass filter 

o Online arithmetic average without low pass filter 

• Low pass filter: The low pass filter frequency in kHz that is used for filtering the raw time signal. 

• Averaging time: Only required for online r.m.s. Each calculated characteristic value is averaged over 
the given period of the raw input signal. 

• Generation frequency: Only required for online r.m.s. The generation frequency states how often the 
characteristic values are calculated. 

• Storage interval: Only required for online r.m.s. The storage interval defines the time span that is used 
to aggregate the calculated characteristic values to one signal. Afterwards the statistical size is 
calculated from that signal and finally saved. 

• Statistical size: Only required for online r.m.s. If maximum is chosen an alarm is generated if the 
learned or absolute threshold is exceeded. If minimum is chosen an alarm is generated if the learned or 
absolute threshold is shortfall.  

• Warn threshold If the warn threshold is exceeded an warn notification is written in the logbook 

• Alarm threshold If the alarm threshold is exceeded an alarm notification is generated. 
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• Warn threshold increase Only required for online r.m.s. and active classification. The increase is 
calculated with the maximum r.m.s. of the learning phase after ending of the learning phase. It can be 
chosen between a percent or relative calculation of the threshold. 

• Warn threshold decrease Only required for online r.m.s. and active classification. The increase is 
calculated with the minimum r.m.s. of the learning phase after ending of the learning phase. It can be 
chosen between a percent or relative calculation of the threshold. 

• Alarm threshold increase Only required for online r.m.s. and active classification. The increase is 
calculated with the maximum r.m.s. of the learning phase after ending of the learning phase. It can be 
chosen between a percent or relative calculation of the threshold. 

• Alarm threshold decrease Only required for online r.m.s. and active classification. The increase is 
calculated with the minimum r.m.s. of the learning phase after ending of the learning phase. It can be 
chosen between a percent or relative calculation of the threshold. 

 
An analysis of the alarm state of the characteristic values is done in the cycle of the storage interval. If the 
characteristic value has a storage interval of one minute and the diagnosis sensitivity for characteristic 
values in the general tab is set to 3, the alarm is generated maximal 3 minutes after the actual alarm 
threshold exceeding. If a short storage interval of e.g. one second is configured, it has to be considered 
that the Peakanalyzer has a system delay of maximal 500 ms and the alarm is generated with this maximal 
delay. Alternatively a number of detection per time can be set up for each characteristic value individually. 
For example if 5 detections per hour are configured, the alarm will be generated when the characteristic 
was exceeded 5 times within hour. The configured diagnosis sensitivity for characteristic values will be 
ignored in this case. 
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5.2.3.2 Process Factors 

 

 
 

On this tab it can be configured how the formerly set process channels should be processed. The time 
signal, that is sampled with the set sampling frequency and generation interval, can be processed to one of 
the following statistical types: 

• arithmetic average 

• quadratic average 

• minimum 

• maximum 

• r.m.s 

• peak value 

• crest factor 

• variance 

• standard deviation 

• skewness 

• range 
 
 
By activating an alarm mode and corresponding thresholds, it is possible to receive warn or alarm 
notifications from the Peakanalyzer if the thresholds are violated. 
The following modes are available: 

• no alarm No warn or alarm notifications are generated 

• exceedment warn or alarm notifications are generated when the given threshold is exceeded 

• shortfall warn or alarm notifications are generated when the given threshold shortfalls 

• out of band warn or alarm notifications are generated when the value is out of the given band 
 



Peakanalyzer Manager Manual 
 
 
 

 

34 / 108 

An analysis of the alarm state of the process factors is done in the cycle of the storage interval of the 
corresponding process channel. If the process channel has a storage interval of one minute and the 
diagnosis sensitivity for process factors in the general tab is set to 3, the alarm is generated maximal 3 
minutes after the actual alarm threshold exceeding. If a short storage interval of e.g. one second is 
configured, it has to be considered that the Peakanalyzer has a system delay of maximal 500 ms and the 
alarm is generated with this maximal delay. Alternatively a number of detection per time can be set up for 
each process factor individually. For example if 5 detections per hour are configured, the alarm will be 
generated when the process factor was exceeded 5 times within hour. The configured diagnosis sensitivity 
for process factors will be ignored in this case. 
 
Additionally a condition can be linked to the alarm generation of a process factor. The configured minimum 
and maximum value of the selected process channel must be in the range. If the process channel is out of 
this range, no alarm will be generated.  
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5.2.3.3 Classfication 

The classfication can be used to automatically learn warn and alarm thresholds for configured online 
characteristic values.  
 

 
 
All configured process channels can be used for the classification. Individual class boundaries can be 
configured for each process information if the maximum amount of classes for this process channel is 
below 100. If more than 100 classes are configured, the classes are auto generated in an adjustable 
minimal and maximal range.  
The learning time determines how long the system evaluates a specific online r.m.s. value in each class 
before a threshold is set. During the learning phase the global thresholds as configured in characteristic 
values is monitored. After the learning phase the maximum r.m.s. of the learning phase is multiplied with 
the threshold increase value, as configured in characteristic values, to determine the learned threshold.   
This allows to learn and monitor the r.m.s. thresholds adopted to the actual system defined by the process 
information.  
 
By setting an alarm lead time, the actual warning or alarm is only generated if the corresponding r.m.s. 
exceeds the threshold over the given time. 
 
Individual classes can be explicitly excluded from the classification if the amount of classes for this process 
channel is below 100. In this case only the absolute configured thresholds under characteristic values are 
monitored. The total amount of classes over all process channels is restricted to 1,000,000.  

5.2.4 Advanced Diagnosis 

5.2.4.1 Drive Elements 

If in the selection list of machines and drive elements a machine is selected, an overview of all sensors and 
their assigned drive elements is shown. 
Furthermore a picture (e.g. technical drawing) can be added in the machine overview of the configuration. 
The sensors can be placed via Drag & Drop on this picture. This picture of the sensor positioning is also 
shown in the machine overview later on. 
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Via the button "Load machine template" a predefined machine template can be loaded into the current 
machine. All drive elements that are configured in the given machine template are inserted to the current 
machine. Only the sensor assignment of the drive elements to the available sensors must be configured.  
 
Additionally a configured machine can be saved in the pool of machine templates by pressing the button 
"Save as machine template". This template is then available in the menu point machine templates and can 
be used by all other Peakanalyzer.  
 

Add Drive Element 
 
To add a drive element to a machine, the drive element type must first be selected from the drop down list. 
The following drive elements are available: 

• Shaft 

• Drive Shaft 

• Clutch 

• Gear Drive 

• Belt Gearing 

• Planetary Gear 

• Rolling Bearing 

• Three-Phase Motor 

• Speed ratio 

• Steady Frequency in FSP 

• Steady Frequency in HKFSP 

• Steady Order in OSP 

• Steady Order in HKOSP 
 
For each drive element the following parameters must be set: 

• Name of drive element An arbitrary name for that drive element 

• Tolerance relative width of the tolerance band for the diagnosis. Each drive element already has useful 
default settings. 

 
For some drive elements additional kinematic parameters must be set that can be obtained from the 
manufacturer or special databases.  
 
After setting all kinematic parameters, the drive element can be assigned to multiple sensors that should 
monitor this drive element. This can be made with an automatic determination of the measurement time. 
Thus an optimal measurement time is calculated by the given speed range (see speed channels) and the 
given kinematic parameters. If multiple drive elements are assigned to one sensor, it can lead to a second 
measurement time for this sensor.  
If the automatic determined measurement time does not met all requirements, it can be adopted manually. 
This counts for all drive elements. In this case it must be ensured by the user that all diagnosis attributes of 
the drive elements can be found in the spectra. 
 
 

Delete Drive Element 
 
A drive element can be deleted from the configuration by selecting it from the list and clicking the button 
"Delete Drive Element". Thus all assigned sensors will also be unlinked from this drive element and the 
measurement time is recalculated for the former assigned sensors. 
 

Copy Drive Element 
 
If multiple identically constructed machines should be monitored by the Peakanalyzer, drive elements can 
be copied from one machine to another. This can be done by selecting and right clicking the relevant drive 
element in the list to open the context menu. Then by choosing the menu Copy the drive element is copied 
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into the clipboard. It can be inserted to another machine by opening the context menu of the new machine 
and clicking Insert. Thus all sensor assignments are deleted for the new drive element. 
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Shaft 

Exactly one shaft in the system must be configured as reference shaft. This is also the shaft where the 
speed is measured. It has always the transmission of 1. The transmission of all other shafts in the machine 
are in relation to this reference shaft. 
 
Normally a tolerance of 0.1 % is suitable. 
 
In the analysis it is searched for loose particles and unbalance on the configured shafts. 

Drive Shaft 

The drive shaft is also a shaft which can be used as reference shaft. 
 
Normally a tolerance of 0.1 % is suitable. 
 
In the analysis it is searched for loose particles, link damage and unbalance on the configured shafts. 

Clutch 

A clutch can be configured as fixed connection or as shifting clutch between two shaft. Therefore the input 
and output shaft must be set to one shaft of the already configured shafts. If this clutch is fixed the option 
coupled has to be set to yes. If the clutch is decoupled due to gear switching the option must be set as free 
parameter. 
 
Normally a tolerance of 0.1 % is suitable. 
 
In the analysis it is searched for misalignment on the configured clutches. 

Gear Drive 

The gear drive describes a spur gear and bevel gear. It must be chosen a shaft for the pinion and wheel 
respectively. It has to be set whether the pinion and wheel are coupled with the shaft or whether the 
coupling between pinion and shaft or wheel and shaft is decoupled due to gear switching. Furthermore the 
number of tooths for the pinion and wheel has to be entered. Additionally the parameter internal toothing 
can be set if one side of the gear drive has an internal toothing. In this case the rotational direction of the 
outgoing shaft is not reversed.  
 
Normally a tolerance of 0.1 % is suitable. 
 
In the analysis it is searched for revolving deviation of flank shapes and local deviation of flank shapes at 
the pinion and wheel on the configured gear drives. 

Belt Gearing 

For the belt gearing the shaft of the driven and driving wheel. It has to be configured whether the driven 
and driving wheel is fixed coupled with the shaft or whether the connection is modified due to gear 
switching. Furthermore the diameter of the driven and driving wheel as well as the length of the belt must 
be defined. 
 
Normally a tolerance of 0.1 % is suitable. 
 
In the analysis it is searched for local irregularities of the belt on the configured belt gearings. 

Planetary Gear 

The planetary gear covers planetary gears with single planets (in contrast to stage planets). The number of 
planets, number of tooth of the planets, sun and annulus must be configured. Furthermore the shafts must 
be selected for the annulus, sun and planetary carrier. 
The mode of the planetary gear must be configured. One of the following combinations can be used: 

• sun and planetary carrier rotate and annulus is fixed 
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• sun and annulus rotate and planetary carrier is fixed 

• planetary carrier and annulus rotate and sun is fixed 

• all shafts rotate 
 
The modes can also be set as free parameter if the state changes due to gear shifting. 
 
Normally a tolerance of 0.1 % is suitable. 
 
In the analysis it is searched for local irregularities of the sun, annulus and planets as well as for revolving 
deviation of flank shapes on the configured planetary gears. 

Rolling Bearing 

For the rolling bearing the kinematic parameters must be configured. These are the rotational cage order, 
the ball spin order, the double ball spin order and the ball pass order of the outer and inner ring. These data 
can be obtained from the manufacturer of the rolling bearing. The input of the rotational orders can be done 
with respect to to order 1 or with respect to the relative speed of the rolling bearing. Alternatively a bearing 
type can be chosen from the bearing database. The data for the rotational orders are then taken from the 
bearing database and can not be changed in the bearing itself.  
 

 
 

Furthermore the shafts for the outer and inner ring must be chosen. If one of these is fixed the shaft can be 
left empty. 
If the rolling bearing is configured as planetary rolling bearing no shafts must be set. 
 
Normally a tolerance of 1 % is suitable to compensate slippage of the rolling bearing. 
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In the analysis it is searched for outer and inner ring damage, cage damage and rolling element damage on 
the configured rolling bearings. 

Three-Phase Motor 

For the three-phase motor the net frequency must be configured. 
 
Normally a tolerance of 0.1 % is suitable. 
 
In the analysis it is searched for magnetic imbalance on the configured three-phase motors. 

Speed ratio 

The drive element speed ratio can be used to dynamically adjust the ratio of an input and output shaft. A 
process channel must be set, that describes the speed ratio between these two shafts. For example the 
actual speed of the two shafts can be measured with a speed sensor and the calculated to a speed ratio 
with the virtual process channels. To validate the remaining drive elements in the configuration, a speed 
ratio can be entered that is only used in the configuration.  
During a measurement the speed ratio should be relatively constant since the average value of the speed 
ratio is used that was measured during the whole measurement time. The maximal percent deviation can 
be entered for this process channel in the diagnosis condition section.  
A monitoring of this drive elements via sensors is not possible. 

Steady Frequency 

The elements steady frequency and steady frequency envelope can be used to monitor individual 
frequencies in the frequency spectrum and envelope frequency spectrum respectively. The frequency must 
be configured. 

Steady Order 

The elements steady order and steady order envelope can be used to monitor individual orders in the order 
spectrum and envelope order spectrum respectively. The order must be configured. 
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5.2.4.2 Diagnosis Conditions 

 
 
There can be two diagnosis conditions defined for each machine that is monitored by the Peakanalyzer. An 
analysis of the measurement data is only done if one of these diagnosis conditions is fulfilled. Furthermore 
the diagnosis condition is used as a precondition for the start of the measurement. 
 
The following common parameters must be set: 

• conditional start time Only if the conditions are fulfilled for the given period a measurement can start 

• unconditional start time If the conditions are not fulfilled for the given period the measurement is started 
anyway. This is required to ensure a regular operational state of the diagnosis system. This value must 
be larger then the conditional start time 

• max. speed change The maximal speed change that is allowed during one measurement. Useful 
values are up to 20% of maximal speed change.  

 
One diagnosis condition can consist the following conditions: 

• Name An arbitrary description of the diagnosis condition that can be used as filter criteria in the 
analysis later on 

• Speed min/max/rotating direction The maximal and minimal speed. The speed range must be fulfilled 
the complete conditional start time period to trigger a measurement. After the measurement is finished 
it is also checked whether the speed was in the range during the measurement time of the 
corresponding speed channel. If the connected speed sensor has also an information about the 
rotating direction via its A and B lines, it is also possible to use the rotating direction as condition. If the 
speed sensor does not have this information a forward rotating machine or engine is assumed. 

• Process range min/max A channel that is configured in the process channels can be selected. A 
minimal and maximal value must be set that should apply to this diagnosis condition. A measurement is 
only started if the given process range is fulfilled the whole conditional start time period. After the 
measurement is finished it is also checked whether the process conditions were fulfilled during the 
measurement time.  

• Digital input as trigger If the Peakanalyzer has digital inputs, theses can be used to directly trigger the 
start of a measurement. The conditional start time will be ignored in this case and the measurement will 
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start immediately. The speed and process channel ranges are checked at then end of the 
measurement to ensure fulfilled conditions during the whole measurement time. 

 

5.2.5 Communication 

 

5.2.5.1 Bus Outputs 

If the Peakanalyzer has a Profibus-Slave, the Profibus can be configured for output information of 
characteristic values, process factors and kinematic alarms of drive elements. These information can be for 
example displayed in a process control system. 
 

 
 
The data structure of the telegram can be defined by the configured characteristic values and process 
factors. There will be permanently all data in the telegram available. If a new value for one field is available 
on the Peakanalyzer, the telegram content will be updated accordingly. The transmitted values are 
multiplied with a scale factor to configure the desired accuracy for Integer formats. Additionally multiple 
status WORD can be added to the telegram where individual warn and alarm threshold exceeding of 
characteristic values, process factors or drive elements can be configured. The telegram of the above 
depicted configuration will have the following structure: 
 

Byte Data type Description 

1-4 32-Bit Floating Point Sensor5: Minimum 

5-8 32-Bit Floating Point Sensor5: Maximum 

9-12 32-Bit Floating Point Sensor6: Minimum 

13-16 32-Bit Floating Point Sensor6: Maximum 

17-18 16-Bit Integer DMS: Minimum 

19-20 16-Bit Integer DMS: Maximum 

21-22 16-Bit Integer DMS: r.m.s 
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23-24 16-Bit Integer DMS: peak value 

25-26 16-Bit Integer DMS: variance 

27-30 32-Bit Integer DMS: standard deviation 

31-34 32-Bit Integer DMS: instantaneous value 

35-38 32-Bit Integer DZ2_Profibus_Int16: Minimum 

39-42 32-Bit Integer DZ2_Profibus_Int16: Maximum 

43-46 32-Bit Integer DZ2_Profibus_Int16: arithmetic average 

47-50 32-Bit Integer Sensor1: r.m.s. of vibration velocity 

51-54 32-Bit Integer Sensor1: r.m.s. of vibration acceleration 

55-58 32-Bit Integer Sensor1: r.m.s. of vibration acceleration envelope 

59-60 16-Bit Integer Status WORD 1 

61-62 16-Bit Integer Status WORD 2 

 
The telegram is set according to this configuration to a size of 31 WORD. The Profibus master must be 
configured accordingly. It has to be note that the data is send in big endian format. The last two WORD 
contain status information of warn and alarm threshold exceeding. Each individual bit can be configured 
with a exceeding. An example configuration of Status WORD 1 is depicted in the following picture: 
 

 

Profibus 

To use the Profibus for input channels the check for "Activate Input" must be set. Furthermore the Profibus-
Slave-Address must be set that is agreed with the Profibus-Master.  
Afterwards the configuration of the input channels is done as described in Bus Outputs.  
 
After transmitting the configuration a 18-WORD telegram is added to the Profibus-Slave in the single mode. 
The data is always transmitted in big endian format. In the multi mode the telegram size depends on the 
number and type of configured outputs. The telegram must be configured equally on the corresponding 
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Profibus-Master. In the program directory of the Peakanalyzer the GSD file of the Profibus-Slave can be 
found which maybe is needed for configuring the Profibus-Master. 

Profinet 

 
 
To use the Profinet-Device for output information, the check "Activate Output" must be set. 
The MAC-Address of the Profinet-Device is provided on this site for the correct configuration of the 
Profinet-Device. Furthermore the last 4 numbers of the Profinet station name can be modified to avoid 
name conflicts with other devices. 
Afterwards the configuration of the outputs is done as described in Bus Outputs.  
 
After transmitting the configuration the telegram with the defined size is applied on the Peakanalyzer. For 
the single mode the telegram size is 32 WORD where only the first 18 WORD are used. In the multi mode 
the telegram size of the Profinet-Device is according to the configured outputs and always round up to the 
next power of two. Thus there are only telegrams of the size 1, 2, 4, 8, 16, 32 or 64 WORD. The data is 
always transmitted in Big Endian format. The telegram structure must be configured on the Profinet-
Controller in the same manner. The GSDML file of the Profinet-Device that may be neccessary for the 
configuration of the Profinet-Controller can be found in the program directory of the Peakanalyzer Manager.  
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5.2.5.2 Digital Outputs 

 
 
Digital outputs can be used to signalize threshold exceedments of process factors or characteristic values. 
Up to 2 digital outputs can be configured for each warn and alarm threshold. If one digital output is 
configured for multiple process factors or characteristic values, the digital output serves as sum alarm. The 
digital output is set if one of the configured characteristic values or process factor is signalized. 
 
The following settings must be set: 
Datatype: The process factor or characteristic value that should be signalized via a digital output 
Warn contact 1: The digital output that is set if the warn threshold is exceeded. 
Warn contact 2: The digital output that is set if the warn threshold is exceeded. 
Alarm contact 1: The digital output that is set if the alarm threshold is exceeded. 
Alarm contact 2: The digital output that is set if the alarm threshold is exceeded. 
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5.2.5.3 Current Outputs 

 
 
Current outputs can be used to output a process factor or a characteristic value as analogue signal (0 to 20 
mA). If a new value of the data type is available it is transferred to the analogue value and output to the 
corresponding channels. This information can be used to display the values in a process control system. 
Only one data type can be configured per current output. The following settings must be configured: 
 
Data type: the process factor or characteristic value that should be outputted 
Current output: the channel for the configured data type 
Sensitivity: the value of the data type is factorized with this value to get the analogue value 
Offset: this values is subtracted from the data type value before the sensitivity is applied 
Measurement range: the resulting output range for the configured data type 
 
In the above example the r.m.s of vibration velocity of one sensor is configured that 4 mA corresponds to 0 
mm/s and 20 mA corresponds to 15 mm/s. 

5.2.5.4 Remote 

The Peakanalyzer can be configured for automatically call a server in a cyclic manor or if an alarm is 
generated. This is done on the tab Remote. 
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Up to 5 server can be configured that are called by the Peakanalyzer. For each entry the following settings 
must be made: 

• IP-Address or DNS server name of the server 

• TCP-Port that is configured on Server 

• Dial-In interval in which the server should be called 

• Dial-In interval to the server if a communication error occurs 

• Dial-In interval from .. to the time of the day where the Peakanalyzer calls the server 
 
It must be ensured that the given server has installed the Peakanalyzer Manager and the service is 
configured with the correct remote port. The configuration of the service can be found in cyclic download. 
Furthermore it must be ensured that the connection is not blocked by any firewall.  

5.2.5.5 E-Mail 

The Peakanalyzer can be configured to automatically send E-Mails if an alarm occurs. 
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To enable this function, the option "Activate E-Mail" must be set first. Afterwards the sender and recipient 
must be configured by the following parameter: 

• Sender The sender of the E-Mail that should be used for the sending 

• SMTP-Server The mail server that should be used for sending the E-Mail 

• SMTP-Port The port of the mail server 

• Username The username to login to the SMTP-Server. This is usually the E-Mail address on most 
providers 

• Password the password to login to the SMTP-Server 

• Recipient The recipient that should receive the E-Mail 

• Language The language of the E-Mail. It can be chosen between German and English 

• Subject prefix This text will be set before the subject of the E-Mail. This can be used to automatically 
filter the E-Mails to categories. 

 
Finally the categories where an alarm should be send can be configured. An arbitrary combination of 
advanced diagnosis, characteristic values and process factors can be chosen. 
After the configuration is transmitted, the Peakanalyzer will automatically send an E-Mail to the recipient if 
an alarm occurs. The E-Mail will contain an information about the current alarm and also a list with all not 
acknowledged alarms that are present on the Peakanalyzer. The alarm suppression time that is configured 
in the storage management will be respected. Thus the same alarm will only notified again if the given time 
is elapsed.  
A test E-Mail can be send from the Peakanalyzer via the button "Send Test E-Mail" to verify the above 
configuration. If an error occurred a corresponding message is displayed. 
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5.2.6 Storage Management 

 
 
On this tab, it can be configured how often and which type of measurement data should be saved. An asset 
history of the relevant measurement data will be saved in the set intervals. Individual intervals can be 
configured for the following measurement and analysis data: 

• Diagnostic attributes Amplitude, order and significance are saved for each damage pattern for each 
monitored drive element.  

• Characteristic values the characteristic values that are configured in the tab characteristic values. 

• Spectra the frequency, envelope frequency, order and envelope order spectra that were calculated 
during the analysis 

• Time Signals the reduced time and envelope time signals that were calculated during the measurement 

• Original Time Signals the 50 kHz raw time signals, that were measured. Saving of raw time signals can 
lead to extensive memory usage on the Peakanalyzer.  

• Process Factor the high resolution (up to 1 kHz) signals of the process channels 

• Characteristic Values the high resolution online characteristic value (up to 1 kHz) 
 
Additionally the data types that should be saved in case of an alarm can be configured. The following types 
are available: 

• Diagnostic attributes 

• Characteristic values 

• Spectra 

• Time Signals 
 
Furthermore it can be configured how long an existing alarm should be suppressed. A specific alarm 
notification is not written to the logbook until the set time is elapsed. 
 
The Peakanalyzer automatically deletes measurement and analysis data that is older than the set duration 
of data storage. If the Peakanalyzer is not available during the given time, the measurement and analysis 
data are lost. 
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5.3 Service Measurement 

The service measurement can be opened on the menu Analysis → Service Measure or on the navigation 
bar at the bottom. This functionality is only available if the view of the Peakanalyzer Manager is in the 
measurement devices mode and a Peakanalyzer is selected in the left tree view. 
The service measurement allows to measure up to 8 channels in parallel on the Peakanalyzer. It has to be 
considered that the measurement is done with the maximum sampling frequency. Therefore a stable and 
good connection via LAN must be established to the Peakanalyzer. On the right side the desired sensors 
can be selected. The sensor settings from the current monitoring configuration are used for the service 
measurement. The setting of the measurement time is independent from the monitoring configuration and 
can be adjusted in steps of one second. By clicking the button "Start Measure" the currently running 
monitoring configuration is stopped if necessary and the service measurement is initialized. The acquired 
measurement data are visualized in the curve window. The service measurement can be stopped at any 
time by clicking "Stop Measure". By clicking on "Save Measure" all measured sensors will be saved in the 
database of the Peakanalyzer. Additionally are frequency and envelope frequency spectra calculated for 
the sensors of the vibration inputs. If furthermore the corresponding reference speed channel is measured, 
order and envelope order spectra are calculated. These data can be viewed and analyzed in the analysis 
section. They can also be exported from there. After the service measurement is finished, it will be asked 
whether the regular monitoring configuration should be restarted.  
 

 

5.4 Data Management 

All data that is generated on the Peakanalyzer as well as the configuration of the Peakanalyzer will be 
saved in a data base per Peakanalyzer on the configured SQL-Server. 
 
During the installation of the Peakanalyzer Manager a Windows background service was installed. This 
service downloads the data of one or multiple Peakanalyzers and adds it into the database. This 
background service, once configured, runs autarkic. Therefore it is not required to open the Peakanalyzer 
Manager or even have an active windows user logged in to download measurement data from the 
Peakanalyzers.  
 
If the Peakanalyzer or a machine is selected in the left tree view in the Peakanalyzer Manager, the button 
Update can be pressed in the navigation bar at the bottom to initiate the update process for measurement 
data and configurations.  
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During the communication with a Peakanalyzer the following actions will take place: 

• Synchronization of the configurations of the Peakanalyzer and the local database 

• Acknowledgment and reset of alarms that were handled via the Peakanalyzer Manager 

• Querying of new alarm notifications 

• Querying of sensor information (broken wire detection, current r.m.s. values, current speed values, 
current process channel information) 

• Closing of the current measurement directory if there is any alarm 

• Download of measurement data 

• Insertion of all measurement data in the local database 

5.4.1 Cyclic Download 

The computer, that have the Peakanalyzer Manager installed, can also be configured to cyclically connect 
to a selection of Peakanalyzers and download the corresponding measurement data. This can be 

configured in the menu Service → Configuration. 
 

 
 
Two time frames and one redial interval can be configured where the computer tries to connect to the 
Peakanalyzers and download the measurement data. To activate a Peakanalyzer the column active must 
be set to local on the corresponding Peakanalyzer. If the Peakanalyzer can respond to a Ping, the check 
box allow ping should be enabled. With this option enabled, the connection will be only established if a Ping 
was successful. 
Furthermore the login data for the Peakanalyzer must be given to automatically download the 
measurement data. These can be set via the properties of the Peakanalyzer. 
 

An overview of the resource utilization and tasks of the configured service is shown in the menu Service → 
Status. In this overview the following information of the service is summarized: 

• active and past action for each Peakanalyzer 

• current progress of the active action for each Peakanalyzer 

• Usage of RAM and CPU of the service 

5.4.2 Backup Strategies 

All measurement data and configurations of one Peakanalyzer can be exported. Thus measurement data 
and configurations can be transfered from one Peakanalyzer Manager to another with a different database 
server connected. To initiate the export the Peakanalyzer must be selected on the left tree view. In the 

menu Diagnosis System → Export a folder must be selected where the backup will be saved. Furthermore 
a timespan must be set when the data was created. 
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Afterwards the backup can be transfered to another PC with Peakanalyzer Manager installed. On this 

target system the backup can be imported via the Peakanalyzer Manager in the menu Diagnosis System → 
Import. After the backup process finished, the measurement data and configurations are available by 
choosing the Peakanalyzer in the left tree view.  

5.4.3 Download Data 

Measurement data and configurations can also be downloaded from a Peakanalyzer without the program 
Peakanalyzer Manager. So it is possible to save the measurement data and configurations initially on a 
removable media and add them later to the Peakanalyzer Manager. To download the data from the 
Peakanalyzer an active LAN connection to the Peakanalyzer must exist. Afterwards a connection via a FTP 
program or the Windows Explorer can be established as follows: 
URL:  ftp://IP-Address:Port 
User:  gfm 
Password: gfm 
 
The IP-Address of the Peakanalyzer must be known beforehand. The default port for the FTP-Access is 
8523. If the port was modified, the set port +2 must be used as FTP-Port. 
If the Peakanalyzer has the following network settings: 
IP-Address: 10.10.210.210 
Port:  6000 - 6004 
 
For FTP access the following URL must be typed in: ftp://10.10.210.210:6002 
 
In the FTP root directory exists a Data and a Konfig directory. These can be saved via the FTP access on a 
notebook or removable media. It is recommended to download the complete directories. 
 
Via the program Peakanalyzer Manager the measurement data and configurations can be added to the 
database of the corresponding Peakanalyzer. The Peakanalyzer must be selected on the left tree view. By 

clicking the menu point Data → "Load from directory", the directory with the Data and Konfig can be 
chosen. The measurement data and configurations will be inserted in the database for the Peakanalyzer 
and are subsequently available in the analysis in the navigation bar at the bottom of the Peakanalyzer 
Manager.  
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5.5 Logbook 

The logbook contains all information that reproduce the operational state of the Peakanalyzer. These 
logbook notifications are divided in the following categories and subcategories and can also be filtered 
accordingly: 

• Alerting 

o vibration diagnosis 

o characteristic values 

o process factors 

o threshold changes 

• Device states 

• Diagnosis states 

• Data storage 

• User access 
 
Furthermore the following criteria can be used to additionally restrict the displayed information: 

• Machine If the logbook is called from a Peakanalyzer with multiple machines configured, the logbook 
entries can be filtered on the selected machine. If the logbook is called directly from a machine, this 
option is disabled. 

• Sensor If a logbook entry is related to a specific sensor (e.g. asset histories or alarm notifications), the 
displayed messages can be filtered to the selected sensor. If a machine was used as a filter criteria, 
the list of available sensors is reduced to the sensors that monitor that specific machine.  

• Drive element If a logbook entry has a reference to a drive element (e.g. alarm notifications), the 
displayed messages can be filtered to the selected drive element. 

• Time frame from/to This criteria allows to filter the displayed logbook entry according to the set time 
frame. 
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5.5.1 Alerting 

The logbook category alerting contains all messages that are generated due to threshold violations. By 
selecting a specific row and clicking "Show measurement data" the Peakanalyzer opens the analysis view 
and displays the related measurement data. The alarm notifications are divided in the following 3 
subcategories: 

• vibration diagnosis This subcategory contains concrete plain text messages about found irregularities 
at one drive element. Such a message is for example: "outer ring damage at rolling bearing Motor A 
measured with Sensor2 (S, Z, M, K). DVS: 1,86".  

• characteristic values This subcategory contains alarm and warn threshold exceeding of configured 
characteristic values. Such a message is for example: "Characteristic value alarm at Sensor2: 12.3 
mm/s" 

• process factors This subcategory contains alarm and warn threshold exceedments or shortfalls for 
configured process factors. Such a message is for example: "Process factor alarm at Wind: arithmetic 
average: 10.00 m/s".  

 
Furthermore the subcategory threshold changes contains all messages that led to an increase or reset of 
alarm thresholds, initiate by an alarm handling of an user. 

5.5.2 Device states 

Th category device states contains notifications of the operational state of the Peakanalyzer. Concrete are 
the following messages displayed: 

• check of over-voltage protection 

• start of the monitoring 

• stop of the monitoring 

• system reboot 

• hardware check 

• power failure detected 

5.5.3 Diagnosis states 

The category diagnosis state summarizes all notification of the fulfilled or not fulfilled diagnosis ranges. 
Thus it can be reproduced which condition was fulfilled at a specific time and therefore an analysis of the 
measurement data was done. Concrete are the following messages displayed: 

• diagnosis range 1 fulfilled at machine 

• diagnosis criteria not fulfilled at machine 

5.5.4 Data storage 

This category contains all messages related to saved measurement data. The time intervals were 
configured in the Storage Management section of the configuration. Such a message is for example: "Save 
asset history at Sensor4 (S, Z, M, K)". The abbreviations describe the data that are saved due to the asset 
history and have the following meaning: 

• S frequency, envelope frequency, order and envelope order spectra 

• Z time, envelope time and speed signals 

• M diagnostic attributes for all drive elements that are monitored by the current sensor 

• K characteristic values that are configured at the current sensor 

5.5.5 User access 

The category user access contains messages that are related to an user interaction with the Peakanalyzer. 
Concrete are the following messages displayed: 

• user logged in 

• configuration transmitted by user 

• alarms acknowledged by user 

• alarms reset by user 
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• data downloaded by user 

5.6 Status Messages 

The status messages provide information about the state of one Peakanalyzer. After the first start of the 
Peakanalyzer Manager the status messages are empty.  
To view the status messages the following steps must be followed: 
 

• The Peakanalyzer must be selected 

• The Peakanalyzer must have a valid configuration 

• The Peakanalyzer must be updated at least once 
 
The update can be done via the following two options. The update can be done automatically via the Cyclic 
download or manually at the bottom via the button "Update". 
 
If the preconditions are met, the status messages can be displayed for the corresponding Peakanalyzer. 
The status messages are displayed by selecting the Peakanalyzer in the tree view. 
One of the displayed categories are the status notifications. Initially only warnings are shown in the status 
messages. These are messages that crossed configured thresholds.  
The button with the black point must be pressed to view all status messages. The black point then turns 
into a blue point. 
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5.6.1 Threshold Settings 

The threshold settings allow to adjust the messages individually. In the menu Service → Configuration must 
be selected to open the threshold settings. In the last column of the selected Peakanalyzer is a button that 
opens when you click a menu. In this menu, there is another button "Adjust" is clicked this, a window open, 
where the thresholds can be adjusted appears. 
 
In the window service configuration it is also possible to adjust the timespan. The timespan is required for 
some statistics that are displayed in the status messages. The timespan is meant backwards from today 
over the given timespan. 
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In the window threshold settings individual thresholds can be set. Initially some thresholds are already set. 
By clicking the button "Add threshold" the new thresholds can be configured. 
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In the column "Status message" it can be chosen between the various available messages. Each message 
requires a context dependent threshold. Some of these messages also require a unit in the column "Unit". 
A detailed description can be found in the chapter Status Messages Description.  
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5.6.2 Status Messages Description 

The following table displays all available status messages in the Peakanalyzer Manager 
 

Status message Description Threshold Parameter 

Last monitoring status shows the status whether the monitoring of the 
Peakanalyzer was active or inactive at the last 
update. 

Active/Inactive 

Last connection shows the date of the last connection to the 
Peakanalyzer 

Timespan: Days::Hours 
(dd:hh) 

Last alarm: Message shows the type of the last alarm Kinematic/Characteristic 
Value/Process 

Last alarm: Date shows the date of the last alarm Timespan: Days::Hours 
(dd:hh) 

Last alarmraise shows the date of the last alarm threshold increase 
by an user 

Timespan: Days::Hours 
(dd:hh) 

Last order spectrum 
(machine based) 

shows the date of the last order spectrum on the 
Peakanalyzer for the monitored machine 

Timespan: Days::Hours 
(dd:hh) 

Last speed in a valid 
evaluation range  
(machine based) 

shows the date of the last valid speed value during 
the last analysis on the Peakanalyzer 

0.0 - 100000.0 in 1/min 

Last start of the 
monitoring 

shows the date of the last start of the monitoring Timespan: Days::Hours 
(dd:hh) 

Last stop of the 
monitoring 

shows the date of the last stop of the monitoring Timespan: Days::Hours 
(dd:hh) 
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Last service measure shows the date of the last service measurement Timespan: Days::Hours 
(dd:hh) 

Last firmware update shows the date of the last firmware update Timespan: Days::Hours 
(dd:hh) 

Last configuration 
transfer 

shows the date of the last transmitted configuration Timespan: Days::Hours 
(dd:hh) 

Last network change shows the date of the last change of the IP address Timespan: Days::Hours 
(dd:hh) 

Hard drive storage: 
Free 

shows the total size of the hard disk in the 
Peakanalyzer 

0 Byte - 100000 TByte 

Hard drive storage: 
Overall 

shows the free size of the hard disk in the 
Peakanalyzer 

0 Byte - 100000 TByte 

Last restart of the 
Peakanalyzer: 
Reason 

shows the reason of the last restart of the 
Peakanalyzer 

by user/unknown/Firmware 
update/Rescan boxes 

Last restart of the 
Peakanalyzer: Time 

shows the date of the last restart of the Peakanalyzer Timespan: Days::Hours 
(dd:hh) 

Last restart of the 
Peakanalyzer: 
Quantity 

show the number of restarts of the Peakanalyzer 
during a timespan. The timespan can be configured 
in the Cyclic Download. If the value is changed the 
Peakanalyzer Manager must update the 
Peakanalyzer. 

0 - 100000 

Ping answertime: 
Minimum 

shows the minimum ping round trip time to the 
Peakanalyzer. 
If the value is 0 ms, the ping was deactivated in 
Cyclic Download. 

0 - 100000 in ms 

Ping answertime: 
Maximum 

shows the maximum ping round trip time to the 
Peakanalyzer. 
If the value is 0 ms, the ping was deactivated in 
Cyclic Download. 

0 - 100000 in ms 

Ping answertime: 
Average 

shows the average ping round trip time to the 
Peakanalyzer during a timespan. The timespan can 
be configured in the Cyclic Download. If the value is 
changed the Peakanalyzer Manager must update the 
Peakanalyzer. 
If the value is 0 ms, the ping was deactivated in 
Cyclic Download. 

0 - 100000 in ms 

Ping packages: 
Receive 

shows the amount of successful pings. If this value is 
0 the ping may be deactivated in the Cyclic 
Download.  
The counter is only for the current day.  

0 - 100000 

Ping packages: Lost shows the amount of failed pings. If this value is 
greater or equal 1 and the amount of successful 
pings is 0, a connection problem exists to the 
Peakanalyzer. 
The counter is only for the current day. 

0 - 100000 

Connection Status: 
Successful 

shows the amount of successful connections to the 
Peakanalyzer during a timespan. If this value is 0 the 
Peakanalyzer Manager have not yet received any 
data from the Peakanalyzer or a connection problem 
occurred. The timespan can be configured in the 
Cyclic Download. If the value is changed the 
Peakanalyzer Manager must update the 
Peakanalyzer. 

0 - 100000 
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Connection Status: 
Broken 

show the amount of interrupted connections to the 
Peakanalyzer during a timespan. This value should 
be 0. Otherwise the connection may be very slow. 
The timespan can be configured in the Cyclic 
Download. If the value is changed the Peakanalyzer 
Manager must update the Peakanalyzer. 

0 - 100000 

Connection Status: 
Failed 

shows the amount of failed connections to the 
Peakanalyzer during a timespan. This value should 
be 0. Otherwise connections problems occurred. The 
timespan can be configured in the Cyclic Download. 
If the value is changed the Peakanalyzer Manager 
must update the Peakanalyzer. 

0 - 100000 

Connect Time: Last shows the last connection time to the Peakanalyzer.  0 - 100000 in ms 

Connect Time: Total shows the total connection time to the Peakanalyzer 
during a timespan. The timespan can be configured 
in the Cyclic Download. If the value is changed the 
Peakanalyzer Manager must update the 
Peakanalyzer. 

0 - 100000 in ms 

Connect Time: 
Average 

shows the average connection time to the 
Peakanalyzer during a timespan. The timespan can 
be configured in the Cyclic Download. If the value is 
changed the Peakanalyzer Manager must update the 
Peakanalyzer. 

0 - 100000 in ms 

Download Speed: 
Last 

shows the last download speed 0 Byte/s - 100000 TByte/s 

Download Speed: 
Average 

show the average download speed during a 
timespan. The timespan can be configured in the 
Cyclic Download. If the value is changed the 
Peakanalyzer Manager must update the 
Peakanalyzer. 

0 Byte/s - 100000 TByte/s 

Amount of data: Last shows the last downloaded data amount. 0 Byte/s - 100000 TByte 

Amount of data: Total shows the total downloaded data amount during a 
timespan. The timespan can be configured in the 
Cyclic Download. If the value is changed the 
Peakanalyzer Manager must update the 
Peakanalyzer. 

0 Byte/s - 100000 TByte 

Amount of data: 
Average 

shows the average downloaded data amount during 
a timespan. The timespan can be configured in the 
Cyclic Download. If the value is changed the 
Peakanalyzer Manager must update the 
Peakanalyzer. 

0 Byte/s - 100000 TByte 

Amount of data: actual 
Month 

shows the downloaded data amount during the 
current month 

0 Byte/s - 100000 TByte 
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6 PeakStore5 

The software Peakanalyzer Manager serves as interface to manage the data collection systems 
PeakStore504, PeakStore508 and PeakStore512. At first the license of the according PeakStore5 must be 
added to the Peakanalyzer Manager. The license manager is available via the menu item Extras → 
Licenses. Via the button Add License the license that is delivered with the PeakStore5 can be added.  
The coupling of the PeakStore5 to the tablet is done via the expansion port in the standard delivery. This 
expansion port is activated automatically during the boot process of the tablet but can also be activated 
manually via the tablet module configuration.  
If the PeakStore5 is used via the separate USB connection in combination with a normal PC, the USB 
connection must be first established before the PeakStore5 is added to the Peakanalyzer Manager.  
Afterwards the PeakStore5 can be added to the Peakanalyzer Manager via the menu item Diagnosis 
system → New → PeakStore. The button Search lists all supported measurement devices that are 
connected via USB.  
The PeakStore5 is than listed in the device browser of the Peakanalyzer Manager like any other system. 
After the selection of the PeakStore5 in the device browser, a query of the channel properties is done and 
the configuration site is opened.  
Via the menu Extras → Options → PeakStore → General the directory where all measurement data should 
be saved can be chosen. Additionally, a shortcut to the desktop or in the Windows startup can be created. 
This will start the Peakanalyzer Manager and automatically select the desired PeakStore5 and will start the 
settling process with the active configuration.  

6.1 Configuration 

In the configuration view, there is a menu bar in the bottom with some general functionalities. The button 
New will create a new configuration. The button Activate will choose the currently opened configuration as 
measurement configuration. This active configuration will also be automatically loaded if the PeakStore5 is 
selected in the device browser. The button Save will save all changes of the currently opened configuration 
if there are no validation errors. If invalid configuration parameters are set, a window will be opened with 
description of the invalid parameter. The button delete will delete the selected configuration. This is only 
possible if there are no measurement data existent for this configuration. If applicable, these have to be 
deleted in the data management first.  
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6.1.1 General 

 
 
The menu tab General of the selected configuration contains the following parameters: 

• Name of Configuration: An arbitrary alphanumeric name to identify the configuration. This name is also 
inserted in the measurement protocol. 

• Configuration Type: It can be chosen between vibration measurement and balancing in one or two 
layer. Details for the balancing can be found in chapter balancing. 

• Online-Calculation of Spectra: This option can be activated if the online calculation of online order and 
frequency spectra is desired during the measurement. If the online calculation is not activated the 
battery life time is increased.  

• Show IP Address for App: If this option is activated, the IP Address of the WLAN adapter of the tablet is 
shown in the sensor overview. 

 
Additionally, the following information are available on the general site: 

• The number of available speed and sensor channels 

• The number of configured speed and sensor channels 

• The date of the calibration data. Also, a new calibration file can be loaded in this section. 
The amount of available measurements with the current channel settings. If the measurement time is set to 
undefined on the vibration channel site, the maximum storage time is shown. 
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6.1.2 Speed Channels 

 
 
On the site Speed Channels the speed sensors can be configured. In general, there are two input channels 

for speed sensors available. Via the button Speed Channels → New a new speed sensor can be added. In 
the table an arbitrary name can be set for this channel. Additionally, the impulses per rotation that are 
measured by the sensor must be adjusted to the correct value. The trigger threshold of the speed channel 
can be adopted if necessary. The speed sensors that are delivered by GfM Gesellschaft für 
Maschinendiagnose mbH work ideal with the standard value of 5 V.  
If no speed sensor is configured, the online calculation of spectra is reduced to frequency and envelope 
frequency spectra. The calculation of order and envelope order spectra requires a speed measurement.  
For the configuration type balancing it is required to measure the speed.  
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6.1.3 Vibration Channels 

 
 
On the configuration site Vibration Channels, the individual analogue inputs can be configured. Via the 

button Vibration Channels → New a new sensor can be added and afterwards be configured in the table. 
The following parameters are available: 

• Name: an arbitrary name for the sensor description or name of the measurement position. 

• Channel: the corresponding input channel 

• Reference Speed: the speed that is used for the order spectra of this sensor 

• Sensitivity / V: the sensitivity of the sensor. If a calibration file is given on the general site, the value 
from the calibration file is used automatically.  

• Offset: the offset of the sensor. For accelerometers with IEPE interface this value is usually 0. For 
analogues displacement sensors, the offset of the displacement sensor must be entered. 

• Unit: the physical unit of the sensor 

• Measurement range: the measurement range of the channel. Here you can select from 10 V to 1 V. 

• Measurement time: the measurement time is changed for all channels accordingly. It can be chosen 
from a pool of 8 measurement times. Alternatively the measurement time can be set to undefined. In 
this case the measurement must be stopped explicitly to finish the measurement.  

• Sampling frequency: The sampling frequency can be set individually for each channel from a pool of 9 
sampling frequencies.  

• Coupling: The coupling can be chosen for each channel individually from IEPE, AC or DC. 
If the configuration type balancing was chosen, a balancing layer must be assigned to each sensor. 
Furthermore, the sampling frequency is fixed to 51.2 kHz for all sensors.  
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6.1.4 Characteristic Values 

 
 
For accelerometers that are configured in the vibration channels site, a characteristic value can be 
configured on this site. If an accelerometer is added, the r.m.s. of vibration velocity based on DIN-ISO 
10816-3 is preconfigured for this sensor. The following r.m.s. values of vibration velocity or vibration 
acceleration can be configured for each sensor: 

• DIN-ISO 10816-3 with bandwidth 10 Hz – 1 kHz 

• DIN ISO 10816-21 with bandwidth 0.1 Hz – 10 Hz 

• DIN ISO 10816-21 with bandwidth 10 Hz – 1 kHz 

• DIN ISO 10816-21 with bandwidth 10 Hz – 2 kHz 

• DIN ISO 10816-21 with bandwidth 10 Hz – 5 kHz 
For each characteristic value a warning and an alarm threshold can be configured. It is than possible to 
monitor warn and alarm threshold exceeding in the measurement overview.  
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6.1.5 Protocol Template 

 
 
A measurement protocol template can be chosen from a pool of templates. The templates of type 
(Drawing) contains a drawing surface where a schema of the machine can be drawn by hand. The data 
type (Picture) contains a preset machine schema picture. Templates with the data type (Empty) omits the 
sensor overview completely. The following templates are available: 

• 2 Spur gear stage + Planetary stage 

• 3 Spur gear stage 

• 4 Spur gear stage + Planetary stage 

• A60-B130 

• Blade bearing 

• Motor 

• Planetary stage + 2 Spur gear stage 

• Motor 

• Motor + Gear box 

• Turbine + Gear box + Generator 

• Empty Template 
 

Additionally, the sensor positions can be placed beforehand if the selected protocol is of the type (Picture). 
These are then used in each measurement with this configuration. At first the check "Activate automatic 
sensor placement" must be set. The desired position has to be clicked to place the sensor. If an already 
placed sensor is clicked again, a popup will open to change the measurement position and direction.  

6.2 Vibration Measurement 

If the PeakStore5 is selected in the device browser, the measurement overview of the active configuration 
is automatically selected. The configured channels will be activated and the settling process of the input 
channels will start. The settling process can also be cancelled. The PeakStore5 is than deactivated and 
must be activated via the button “Activate PeakStore” before a measurement starts. If the PeakStore5 is 
active, the PeakStore5 can be deactivated via the same button or the function key Fn2 on the top of the 
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PeakStore5. If activated, the PeakStore5 is in a monitoring mode where the current characteristic values 
and the current speed can be viewed.  
This also increases the power consumption of the PeakStore5. If the monitoring mode is not needed, it is 
recommended to deactivate the PeakStore5 to increase the battery life time.  
A measurement can be started by pressing the Start button in the right bottom of the application. 
Alternatively the function key Fn1 on the front bottom of the tablet can be used to start a measurement. If 
the PeakStore5 is deactivated, the settling process will start first before the actual measurement is started 
automatically.  
If a predefined measurement time is configured and the measurement is cancelled via the stop button 
during the measurement time, all measurement data of the current measurement will be withdrawn.  
To switch between the different measurement views, the navigation buttons in the right top of the 
application can be used. The Home button always leads to the sensor overview. 

6.2.1 Sensor Overview 

 
 
The sensor overview site is the main site of the measurement overview. Above the actual sensor 
information are buttons to open the current configuration and to open the data management as well as the 
activation/deactivation of the PeakStore5. Additionally, there are information of the current measurement 
start time and the current measurement number. Also the available free measurements that depend on the 
free disk space is shown.  
For the individual sensors the following information are displayed: 

• Accelerometers: The current characteristic value that is configured for this sensor.  

• Displacement sensors and other sensors: The current measurement value is shown. 

• Speed: The current speed value. Additionally, the variation of the speed in percent during the 
measurement. 

By pressing on the sensor, the time signal of the selected sensor will be shown.  
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6.2.2 Measurement Protocol 

 
 
All relevant additional information that are important for the measurement can be added in the 
measurement protocol. Depending on the chosen measurement protocol template in the configuration, the 
provided data can vary. Some information will be filled automatically, like the configuration name, the 
current measurement number and the date of measurement.  
The measurement protocol is divided in the following categories: 
 
General 

• Name and company of the measurer  

• Measurement start time will be filled automatically 
 
Machine information 

• Manufacturer, type, number, location, nominal power and operator of the machine 

• Manufacturer, type, number, nominal speed and ratio of the gear box if present 

• Manufacturer, type, number and bearing description of the motor or generator 
 
Speed measurement 

• Positioning of the speed sensor 

• Impulse per revolution is taken from the configuration 
 
Measurement 

• Current measurement number will be filled automatically 

• Configuration name will be filled automatically 

• Order number if available 

• Process information, e.g. current wind speed or actual power output 
 
Sensor overview 
The measurement protocol templates of type (Picture) have a preset picture. The measurement positions of 
the individual sensors can be placed on this picture. The desired position has to be clicked to place the 
sensor. If an already placed sensor is clicked again, a popup will open to change the measurement position 
and direction.  
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If the same sensor arrangement is used in multiple measurements, it is recommended to save the 
positioning. This can be done by pressing the save button above the picture. The position will be saved 
under the given name. By pressing the load button the selected positioning is applied to the current picture.  
If a measurement protocol template of data type (Drawing) is chosen, a schema picture of the machine can 
be drawn by hand. The drawing mode can be activated by pressing the Design button in the sensor 
overview. The empty box can be used to draw any picture. The completed picture can be saved as 
separate picture file or copied to the clipboard to use it in another application. Additionally, there are 
functionalities to revert the last operation, erase parts of the picture or delete the complete picture.  
 
Miscellaneous 

• An arbitrary text that can contain additional information of the measurement 
 

6.2.3 Time Signals 

 
 
On this site the measured time signals of all sensors, also in parallel, can be viewed. The signals that 
should be shown, can be changed by the sensor listing on the right side. The curve window is frequently 
updated to show the latest data during the measurement. If the measurement is finished, the curve window 
can be zoomed freely to show certain parts in detail.  
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6.2.4 Spectra 

 
 
 

If the online calculation of spectra is activated in the configuration, the order, envelope order, frequency 
and envelope frequency spectra of up to four sensors can be displayed. The spectrum type can be chosen 
by the buttons above the curve window. The spectra are recalculated multiple times during the 
measurement with increasing resolution. Thus the spectra with the best resolution are available at the end 
of the measurement. If an undefined measurement time is chosen, the resolution of the calculated spectra 
will increase up to 163,84 s. From this point on the last 163,84 s are used in a ring buffer system to 
calculate a new spectrum. 
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6.2.5 Characteristic Values 

 
 
Warning and alarm thresholds can be configured for each characteristic value of the accelerometers. The 
visualization of the characteristic values can be found on the characteristic value site. The characteristic 
value is recalculated continuously during the measurement for each sensor. The graphical view displays 
the minimal and maximal value during a measurement with a horizontal line. The current characteristic 
value is visualized with a small arrow. The configured warning and alarm thresholds are emphasized with 
green, yellow and red ranges. If the mouse is hold over a sensor, the concrete values are shown in a 
popup window.  
For connected displacement sensors, speed sensors or other sensors the minimal, maximal and current 
value of the physical measured unit are shown.  
The upper bound of the y-axis is adjusted simultaneously for all characteristic values of the same type. This 
allows an easier comparison of the characteristic values. This behavior can be changed in the options 

under Extras → Options → PeakStore → Characteristic Values. Furthermore the coloring of the sensor 
name can be changed to show different characteristic value types in different colors.  

6.3 Balancing 

If a configuration of type balancing is selected, the measurement view for the balancing process is shown. 
The usual sensor overview from the vibration measurement is replaced by an assistant driven overview for 
the balancing process. The pages for time signals (see Time Signals), online spectra (see Spectra) and 
characteristic values (see Characteristic Values) are identical to the vibration measurement.  
The balancing process is done in multiple stages. At first an origin measurement is done to determine the 
initial imbalance of the machine. Afterwards a test measurement with a test mass is required to calibrate 
the system. If the balancing is configured for two layers, a second test measurement on the second layer is 
required. Afterwards up to 5 validation measurements will follow where balancing masses are applied to the 
layers to reduce the initial imbalance.  
Generally, each measurement consists of a preparation phase, the actual measurement and an 
acknowledgment of the current measurement. If a misconfiguration was done, the current step can be 
cancelled at any time to go back to the last step. During the measurement phase, the PeakStore will wait 
until the speed is in a valid range and then start the actual measurement. If the speed changes during the 
measurement to an invalid range, the measurement is stopped immediately. The speed must be in the 
valid range to automatically restart the measurement.  
The main results of the balancing process are aggregated in a polar view and can be shown at any time of 
the measurement. 
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A protocol of the whole balancing process is shown and saved after the balancing process is finished. 

6.3.1 Preparation 

Before the actual balancing process can be started, the vibration sensors and the speed sensor must be 
applied. A reflection mark must be placed ideally on one of the balancing layers for the speed 
measurement. This mark is also the 0° reference position for the later process that is relevant for applying 
masses. The speed sensor must be placed with the holder that it shows directly on the reflection mark. 
Additionally, the vibration sensors must be placed directly on the bearing of the balancing layer. Ideally it is 
placed directly on the housing of the bearing. The type of the vibration sensor must be chosen that the 
lower cut off frequency is below the speed frequency. If configuration type is set to balancing in one layer, 
the vibration sensor must be placed on this layer. If balancing in two layers is activated, one vibration 
sensor must be placed on each layer. It is necessary to take into account the correct layer for each 
vibration sensor, as parametrized in the configuration (see also Vibration Channels).  
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Afterwards, the following parameter must be set for the whole balancing process (see also above Picture): 

• Target speed: This speed is used for the whole balancing process. Ideally the balancing process is 
done at normal operational speed of the machine. It should be avoided to balance the machine in the 
resonance range. 

• Speed tolerance: The acceptable deviation from the given target speed. A maximum tolerance of 50% 
is allowed. 

• Number of revolutions: One measurement in the balancing process is done with the given number of 
revolutions. It will be automatically rounded to the nearest power of two. The expected measurement 
time directly results from the combination of the number of revolutions and the target speed. 

• Balancing target: The imbalance of the machine can be determined via the measured vibration 
acceleration or via the inferred vibration velocity. 

• Count direction: It can be chosen between clockwise and counterclockwise. The reflection mark always 
references the position 0°. The count direction on the balancing layer is always from the perspective of 
the speed sensor, thus with view on the reflection mark. 

• Use fixed positions: If masses can only be applied to dedicated positions, this option must be checked. 
The positions must be distributed equidistantly over the whole balancing layer. 

• Number of fixed positions: The number of fixed positions must be entered here, if the option “use fixed 
positions” is activated.  

• Rotor mass: The mass of the rotor in gram. The information is required to calculate the quality level 
after the balancing according to DIN ISO 21940-11:2017-03.  

• Radius of mass positions: For the calculation of the quality level according to DIN ISO 21940-11:2017-
03 the radius of mass positions is also required. It is the distance of the mass position to the centre of 
the balancing layer. On these positions the test masses as well as the balancing masses must be 
applied.  

6.3.2 Origin Measurement 

The origin measurement can be started by clicking on continue, if all parameters are set up. It will be first 
waited until the speed is in the valid range. If this is the case the actual measurement starts automatically 
and also stops automatically if the required number of revolutions are reached.  
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6.3.3 Test Measurement 

A calibration of the system is required to calculate the correct balancing masses. For a balancing in one 
layer, a test measurement with a test mass on this layer is required. If the balancing is done in two layers, 
an additional test measurement with a test mass on the second layer must be done. The test masses must 
be removed from the corresponding layer after each test measurement. The example in below Picture 
shows an application of a test mass of 80 g at position 60°. After the machine is at the expected target 
speed, the measurement can be started. If the balancing is done in two layers, the mass can be removed 
from the first layer and applied to the second layer.  
 

 

6.3.4 Validation Measurement 

The balancing masses to correct the initial imbalance are calculated after the successful test measurement. 
If the option “use fixed positions” was activated, two masses per layer are calculated. The picture below 
shows an exemplary calculation of required balancing masses to reduce the initial imbalance. If it is not 
possible to apply the exact masses to the locations, the actually applied masses can be entered.  
 

 
 

After the masses are applied, a validation measurement is required. The determined quality level will be 
shown in the window afterwards. If the required quality level was not reached, a further validation 
measurement can be added to the balancing process. The additionally calculated masses must be added 
to the existing masses from the last validation measurement. This step can be repeated up to 5 times.  

6.3.5 Finalization 

If the target quality level is within the desired range, the balancing process can be finished after the 
validation measurement. The protocol of the balancing process will directly be shown in an internal pdf 
viewer. The measurement data and protocol are also available in the data management section afterwards.  
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6.4 Data Management 

 
 
The data management handles all recorded measurement data of the PeakStore5. All measurement data 
are structured in the left tree view. The button View above the measurement listing allows to change the 
structuring of the measurement data listing. The following options are available: 

• Machine View: The measurement data is grouped according to the measured machine. 

• Configuration View: The measurement data is grouped according to the used configuration. 
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• Order View: The measurement data is grouped according to the order number that was entered in the 
measurement protocol. 

• Chronology View: The measurement data is listed chronologically without any further grouping. 
If one measurement is selected, the measurement data can be visualized by pressing the button “Show 
measurement”. On the right side, the desired sensors can be chosen. By default the speed signal is 
preselected if one measurement is shown.  
If there are additionally photos saved, that were recorded with the PeakStore Remote App, these can be 
displayed by pressing the button “Show photos”.  
 

 
 
The generated measurement protocol can be viewed in an integrated pdf viewer if the button „Show report” 
is pressed. From this view the pdf can also be saved in a separate file or be outputted to a connected 
printer.  
If the measurement protocol contains erroneous inputs, the entered data can be changed by pressing the 
button “Change report”. This will open the edit mode of the measurement protocol as described in the 
measurement overview. To save the changes, the button “Save report” has to be pressed.  
If measurements or complete machines in the left data browser are selected with a check, these data can 
be exported, deleted or calculated with the Diagnostic Tool. For the data export a separate window will 
open where the desired target directory can be chosen. Thus a connected USB-Stick can be chosen to 
export the data. The selected measurement data will be compressed to a single file for all measurements or 
a single file per measurement. The measurement data will be exported to the GfM internal raw data format 
by default. Alternatively, the data can be exported to WAV or ASCII format.   
If desired, the measurement data can be deleted after the export finishes.  
Additionally the measurement data can be transmitted to a FTP server. For example the data can be 
transferred to GfM Gesellschaft für Maschinendiagnose mbH directly after the measurement for an 
analysis. Alternatively the measurement data can be uploaded to any other FTP server. A stable internet 
connection, e.g. via WLAN, must be available to use the FTP upload functionality. Also the FTP login data 
must be known.  
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Via the button „Delete“ all selected measurement data will be completely deleted from the PeakStore5 after 
an additional question.  
The selected measurement data can be calculated with the Diagnostic Tool if the button “Calculate” is 
pressed. The Diagnostic Tool will open and the checked data will be preselected for further editing and 
calculation.  

6.5 Remote Control 

There is a free of charge App for the Smartphone platforms Android from version 4.1 and iOS from version 
9.2 available that allows the remote control of the PeakStore5. The PeakStore Remote App must be 
installed from the corresponding Store. An active WLAN connection must be established between 
Smartphone and PeakStore5 to get the PeakStore Remote App working. It is recommended to use an 
additional WLAN route as access point between these two where both devices are connected to. A battery 
driven WLAN router can also be ordered as additional component at GfM Gesellschaft für 
Maschinendiagnose mbH. 
 

 
 
If the WLAN connection is established on both sides, the PeakStore Remote App can be started and a 
broadcast search for the PeakStore5 can be done. If the PeakStore5 is not automatically found, the 
PeakStore5 can be added manually. Therefore the IP address of the WLAN connection of the tablet, that is 
shown in the sensor overview if configured, must be entered in the App.  
If the connection to the PeakStore5 is established successfully, the overview page will open. The 
PeakStore5 must be in the measurement overview. If the configuration view or data management is 
opened, a measurement can not be started.  
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In the upper part of the App common information of the measurement are displayed. These are: 

• The name of the configuration 

• The measurement progress in percent 

• The current measurement time 

• The current measurement number 
The measurement progress is also visualized with the progress bar.  
Furthermore there is an overview of all sensors with their current, minimal and maximal characteristic 
values of accelerometers or speed values of speed sensors displayed. The minimal and maximal values 
are only updated during a measurement. If the measurement is currently stopped, only the current value is 
updated.  
Via the button Start on the right bottom a measurement can be started. If a configuration with an undefined 
measurement time is activated, the measurement can also be stopped with the same button. 
Additionally photos can be taken and saved in the measurement with the PeakStore Remote App. These 
can be photos of type designations, photos of the machine or sensor positioning. The taken photos are 
directly transmitted to the PeakStore5 and are saved in the current measurement after confirmation. An 
arbitrary free description and a category (machine picture, generator picture, gear box picture or other) can 
be added for each picture.  
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7 Diagnostic Tool 

The Diagnostic Tool provides the functionality to calculate measurement data of PeakStore5 and other 
measurement systems. According to the configuration frequency and envelope spectra as well as order 
and envelope order spectra are calculated. Additionally the characteristic values r.m.s. of vibration velocity 
and vibration acceleration are calculated for each accelerometer. Furthermore the kinematic of the 
complete machine can be entered in the fully licensed version. Found irregularities on the configured drive 
elements are then reported. A future version will also contain a full report generator to create a complete 
diagnosis report in the Peakanalyzer Manager.  
The fully licensed Diagnostic Tool can read the following data formats besides the PeakStore5 data: 

• PeakStore200, PeakStore400, PeakStore410 

• DasyLab 

• Famos 

• Diadem 

• Universal File Format 

• Bachmann 
 

The Diagnostic Tool can be opened via the menu point Diagnosis System → Diagnostic Tool if at least one 
license is added in the license manager.  

7.1 Licensing 

 
 

Via the menu point Extras → License an overview of all added licenses is shown. Licenses of the following 
types can be added: 

• PeakStore5 (Diagnostic Tool Standard) 

• Diagnostic Tool Professional 

• Diagnostic Tool Ultimate 
 
The Diagnostic Tool Standard license can be added to any number of computers. The license allows the 
calculation of measurement data that are from the PeakStore5 with the specific serial number. If only 
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PeakStore5 licenses are added to the license manager, all other data formats are not recognized. The 
license of the PeakStore5 has only a reduced functionality. All kinds of spectra and characteristic values 
can be calculated, but the search for kinematic patterns and the report generator is not available. The 
Diagnostic Tool Professional and Ultimate license is bound to a specific computer and can not be 
transferred to another computer. The Diagnostic Tool Standard license supports all available data formats. 
With the Diagnostic Tool Ultimate license all data can be also analyzed with an advanced analysis.  

7.2 Measurement Selection 

 
 
Via the button Browse a measurement directory can be chosen in the Diagnostic Tool. Afterwards the 
selected directory can scanned recursively for measurement data via the button Scan. After the scan is 
finished, all measurement data that are supported by the Peakanalyzer Manager are shown in the left data 
browser. The listed measurement data can be grouped by the following categories: 

• Raw data: the measurement data are listed according to their directory structure 

• Machine: the measurement data are grouped by the measured machine 

• Order: the measurement data are grouped by the entered order number 
 
The order number and machine name can be individually adjusted for each measurement. Accordingly the 
corresponding data browser view is adjusted.  
It is possible to exclude single measurements from the calculation. This can be done by opening the 
context menu of the entry by right clicking and clicking delete. For each measurement, the read raw signals 
can be viewed by selecting the desired measurement. The speed signal is shown by default if available. 
Via the selection box raw signal in the right bottom any other time signal can be displayed.  
Above the curve window all process information like speed, wind or power that are saved in the 
measurement are shown. These can also be edited and extended individually for each measurement. 
These process factors can be used later for filtering the shown data in the analysis. 
Additionally the following general information are shown: 

• Data format of the measurement 

• Name of the measurement device 

• Measurement date 

• Measurement number 

• Machine name 

• Order number 
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• Output directory 
 
In the output directory, a subdirectory with the measurement date will be created to save all the calculated 
results. This directory can also be a network drive. Especially if multiple computer in the network uses the 
Diagnostic Tool with the same database it is strongly advised to use an output directory that is available on 
all computer. Otherwise the calculated data can not be opened on the other computer. Additionally the 
output directory will contain the original raw data. Thus the input directory can be on a local drive and only 
the output directory on a network drive. The output directory should not be moved or deleted manually. 
Otherwise the Peakanalyzer Manager can not access the data anymore.  
 
Before the actual calculation is done, each measurement can be configured with an individual 
preprocessing. Further information are described in the next chapter. Via the button "Calculate All Data" in 
the left bottom, all measurement data that are shown in the data browser are calculated. Afterwards the 
calculated machines are added to the device browser in the Peakanalyzer Manager. These can then be 
displayed and analyzed as described in Analysis.  

7.3 Preprocessing 

Each measurement that is listed in the data browser can be configured with an individual preprocessing. 
The processed signals can be viewed via the selection in the right bottom. Especially for the speed 
processing it is advised to check whether the result meets the expectation. The following preprocessing 
options are available: 
 
Fixed Speed 
 
If no speed was measured and the machine was driven with a fixed speed, the speed value can be directly 
entered. This option can be applied to all other measurements in the data browser. 
 
Speed from impulse signal 
 

 
 
If the signal of the speed sensor was measured analogues, the square pulse signal can be converted into a 
speed signal. The correct time signal must be chosen and the trigger threshold must be adjusted. The 
threshold can be entered manually. Alternatively the time signal can be display via the show button. The 
trigger threshold can be then dragged in the curve window. The result should be verified afterwards.  
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Speed from meshing 
 

 
 
With this function the speed signal can be determined by the meshing frequency of a gear box. From the 
selected sensor signal short-FFTs are calculated and displayed as spectrogram. A frequency range of a 
significant frequency, for example the meshing frequency, can then be selected in the displayed curve 
window. The range can be selected by dragging the gray area on the desired frequency. Alternatively the 
frequency start and end point can be entered manually. Additionally a factor can be entered that is 
corresponds to the multiple of the actual speed value.  
 
Impulse correction 
 
If the measurement was done with the wrong number of impulses per revolution, this factor can be 
corrected with this this function. This option can be applied to all other measurements in the data browser. 
 
Eliminate outlier in speed signal 
 
If the speed signal contains spikes or outlier, these can be eliminated. The detected part is replaced with a 
linear interpolation of the start and end value of the replacement. This option can be applied to all other 
measurements in the data browser. 
 
Smooth speed signal 
 
The speed signal can be smoothened over the entered time period to eliminate noise. This option can be 
applied to all other measurements in the data browser. 
 
Cut signals 
 
If the measurement contains unwanted effects like a run-up of the machine, the signals can be cut to leave 
out the undesired part. An arbitrary sensor can be chosen to select the desired range by displaying the 
sensor signal and drag the gray area accordingly. During the calculation, all sensor signals are cut to the 
same length.  
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Change unit 
 
If the measurement device was configured with the wrong unit or sensitivity, these parameters can be 
corrected with this function. The unit and sensitivity can be adjusted for each sensor separately. This option 
can be applied to all other measurements in the data browser. 
 
Change sampling frequency 
 
If the raw data contains the wrong sampling frequency, this value can be corrected. This will only change 
the sampling time between two data points. There will be no interpolation of the data with the new sampling 
frequency. This option can be applied to all other measurements in the data browser. 
 
Envelope 
 
The high-pass filter for the envelope calculation can be adjusted. Especially for large structures with slow 
speed it may be wise to set a smaller frequency for the envelope calculation. For the most applications the 
default value of 2 kHz is sufficient. This option can be applied to all other measurements in the data 
browser. 
 
FFT Parameter 
 
The length of the resulting spectra can be adjusted with this setting. This is only an approximate value. The 
actual value will be determined during the calculation by rounding to the next FFT size. This option can be 
applied to all other measurements in the data browser. 
 
Sensor assignment 
 
The labeling of the sensor can be changed for example to adjust the name to the actual measurement 
position. The sensor signals are listed under the new name in the analysis. A complete sensor assignment 
can also be saved as a scheme. This scheme can then be applied to other measurements. The scheme is 
only applied to sensors with the same origin name. The saved schemes for the sensor assignment can be 

edited via the menu point Templates → Diagnostic Tool → Sensor Assignment. 
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The individual assignment of sensor names can be edited for each scheme. Thus it is possible to have the 
same target sensor name for multiple source sensor names to for example support nomenclatures of 
different measurement devices in one scheme. 

7.4 Base Diagnosis 

All machines and corresponding measurements that are calculated can be configured with individual 
characteristic values. To configure these characteristic values the machine has to be selected in the left 
data browser. Alternatively the machine can be selected by clicking on the button next to the machine 
name on the general information tab of an active measurement. 
 

 
 
Each sensor can be configured with one or multiple characteristic values with each individual warn and 
alarm thresholds. 
Important: If the sensor assignment of one measurement is changed, the characteristic values are reset to 
its default values. Thus it is practicable to first set the sensor assignment of the measurements correctly 
and then configure the characteristic values as desired.  
 
To facilitate the configuration of the characteristic values, it is possible to create templates for all or specific 
sensor names. 
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Templates of characteristic values can be edited via the menu point Templates → Diagnostic Tool → 
Characteristic Values. Multiple different characteristic values can be created for each sensor name. 
Additionally templates that are used for all sensors can be created. These have to use the sensor name 
"[General]". After the characteristic values are saved, they are available upon the next configuration of a 
Diagnostic Tool setup.  
 
If the warn and alarm thresholds are configured, the corresponding warn and alarm bands are shown in the 
subsequent data analysis. An alarm threshold exceeding is also shown in the machine overview as 
characteristic value alarm of the corresponding machine afterwards. Via this alarm the data in the analysis 
can also be shown up. 

7.5 Advanced Diagnosis 

With a license of the Diagnostic Tool Ultimate it is possible to enter a kinematic for a machine. If a certain 
machine is measured and calculated several times, it is useful to enter the kinematic of the machine as 
template to reuse this template on subsequent calculations. By this procedure it is also ensured that the 
calculated data of drive elements are shown in connection to the previous data in the analysis. 
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The machine template can be directly chosen and loaded in the overview of drive elements. Afterwards 
only the assignments of drive elements to the sensors must be set. The kinematic can be extended by 
further drive elements or be build up completely by adding drive elements. The whole configuration of the 
gear is described in detailed in the section drive elements.  
 
Important: If the sensor assignment of one measurement is changed, the drive element assignments are 
reset to its default values. Thus it is practicable to first set the sensor assignment of the measurements 
correctly and then configure the kinematic as desired.  
 
After the calculation, the found irregularities are listed as alarms of vibration diagnosis in the machine 
overview of the corresponding machine. From this view it is also possible to directly show the spectrum with 
marked diagnosis attributes to verify the found irregularities.  

7.6 Calculation 

Via the button "Calculate All Data" on the left bottom, the following data are calculated for all 
measurements in the data browser: 

• frequency and envelope spectra 

• order and envelope order spectra if a valid speed signal exists 

• r.m.s. of vibration velocity and vibration acceleration for all vibration signals 
 
The resulting data are saved under the configured machine. After the calculation the machine is added to 
the device browser in the Peakanalyzer Manager and can be viewed in the analysis. If the same 
measurement is calculated again, the old result will be withdrawn and replaced with the new one. A 
message will be displayed on the corresponding measurement in the data browser. 
 
The resulting machine and its data can be additionally saved for backup purposes via the menu Diagnosis 

System → Export.  
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8 Machine Overview 

The state of the machine can be observed on multiple layers. If an hierarchical layer is selected in the 
device browser, all machines that are in this layer or subsequent layers are shown. Thus a short overview 
over multiple machines distributed over multiple plants or locations is possible.  
 

 
 
In this view the number of alarms that are currently present on this machine are shown. Additionally a time 
frame can be set to view the number of alarms that occurred in the given time frame. Each machine can be 
unfolded to show further details of the machine, for example the number of alarms separated by the type. 
The machines can be filtered by several criteria. Thus it is possible to show only all Peakanalyzer or their 
corresponding machines that have connection problems. For each individual machine the user defined 
comments as well as the number of user defined comments in the filtered time frame are shown. Via the 
button add user comment in the top next to the name of the hierarchical layer, a user comment can be 
added to the Peakanalyzer or machines in this layer. This function is also available if the machine view of 
one individual machine is displayed.  
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A priority can be chosen, when a new user comment is added. The user comments with higher priority are 
also indicated in the device browser. A user comment with priority urgent will result in a red color for the 
machine, a monitor priority colors the machine yellow and a normal comment will not change the color of 
the machine. Additionally an expiration can be entered for the comment. The comment is than only shown 
until this date in the machine overview. Nevertheless it is available in the logbook afterwards. The comment 
can be added for a Peakanalyzer as well as for the machine that are in this layer.  
 
By selecting the machine in the device browser or via the arrow next to the machine name in the group 
overview, the detailed machine view is displayed. This view shows individual information for each alarm. If 
an alarm is present in a certain category, the corresponding box is expanded and the machine is colored 
red in the left tree view. The following detailed views are visible for one machine: 

• General Information 

• Sensor Overview 

• Alarms Vibration Diagnosis 

• Alarms Characteristic Values 

• Alarms Process Factors 
  



Peakanalyzer Manager Manual 
 
 
 

 

90 / 108 

8.1 General Information 

 
 

In the general information, the machine details that were entered during the configuration are show. 
Additionally the sensor positioning from the configuration is displayed. Furthermore the user comments that 
are not yet expired are shown. The user comments can also be deleted in this view. 

8.2 Sensor Overview 

The sensor overview states all relevant data of all configured sensors. Dependent of the connected 
channel the following information are shown: 
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IEPE 
State of broken wire detection connected or not connected 
Last characteristic value Dependent of the configured characteristic values the r.m.s. of the vibration 
velocity or vibration acceleration based on DIN-ISO 10816-21 or DIN-ISO 10816-3 is shown. 
 
Process channels 
The last momentary value is shown 
 
Speed 
The last measured speed value is shown 
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8.3 Alarms Vibration Diagnosis 

 
 
The overview for the alarms of the vibration diagnosis contains detailed notifications for found irregularities 
on individual drive elements. The corresponding measurement data can directly be shown in the analysis 
from this notifications.  
 
By clicking the green check individual alarms or all alarms of one drive element of all existing alarm can be 
acknowledged. It will be asked whether the acknowledgment should be done with or without increase of the 
alarm threshold. A default value is given for the alarm threshold increase. This default value can be 

changed in the menu Extras → Options in the tab Alerting.  
 
If a rolling bearing or other drive element was exchanged, the corresponding alarm thresholds must be also 
reset. A button in the top row "reset drive element" provides this functionality. In the opening dialog it can 
be chosen between resetting one specific or all drive elements.  
 
After the next synchronization with the Peakanalyzer, the alarms will be acknowledged or reset on the 
Peakanalyzer. Thus it is possible to handle all alarms without a direct connection or waiting for a 
connection to the Peakanalyzer.   

8.4 Alarms Characteristic Values 

If the configuration contains alarm thresholds for characteristic values, notifications about threshold 
exceedments are listed in this box. 
 
They can be individually acknowledged by clicking the red check and optionally modifying the threshold. A 
reset of the alarm threshold will set the threshold to the value when the configuration was transmitted to the 
Peakanalyzer.  

8.5 Alarms Process Factors 

If the configuration contains alarm thresholds for process factors, notifications about threshold violations 
are listed in this box. 
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They can be individually acknowledged by clicking the red check and optionally modifying the threshold. A 
reset of the alarm threshold will set the threshold to the value when the configuration was transmitted to the 
Peakanalyzer.  
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9 Analysis 

9.1 Data Selection 

Measurement data that should be visualized in a curve window can be selected in the data selection tree. 
For each data type a different curve window is used. There can be up to 10 signals of the same data type 
be visualized in a row or on top of each other. Multiple signals can be selected by holding the Ctrl-Key and 
clicking with the left mouse button. To select a block of measurement data, the Shift key can be hold while 
selecting a signal within data type with the left mouse button. 
 

Spectra/Time Signals 

 
The context menu allows to additional selecting data that was generated in the same measurement. So it is 
possible to show the related speed signal of an order spectrum if it was saved in this measurement. 
Furthermore the same data type of another sensor can be shown. It is automatically the measurement 
chosen that is closest to the current measurement.  
 
Via the context menu the selected signal can also be exported to raw-Format (.raw), GfM-Intern Format 
(.grw) or ASCII-Format (.asc) to edit or view them with other programs. 
Additionally time signals can be exported to the .wav-Format and play them in an external Audio-Player. 
Alternatively the time signals can be outputted via the internal player to the standard output of the sound 
card. 
 

Diagnostic Attributes 

 
The diagnostic attributes that are also used for the alarm determination can be displayed for each 
configured drive element. The context menu offers the option to display the amplitude, order or DVS value 
of the diagnostic attributes. Also an combination of these types is possible. For these data types a trend 
can additionally visualized in an configurable time interval. Thus the evolution of the irregularities can be 
tracked over a longer period. 
 

Process Factors 

 
All permanent measured signals can be displayed in this section. That are all statistical types that were 
configured for the process channels. Additionally the minimum, maximum and arithmetic average of all 
configured and permanent measured speed channels can be displayed. 

9.2 Curve Window 

Following an overview of the control of the curve window is listed: 
 

Key Action 

Cursor left/right at activated cursor: Movement of the cursor to the left/right 

Alt + Cursor left/right move the X-axis to the left/right 

Ctrl + Cursor left/right at activated cursor: extended functionality of the cursor 

Shift + Cursor left/right at activated measurement cursor: move both cursor, that the distance 
between both cursor stays the same 

mouse wheel up/down zoom out/zoom in on both axis 

Shift + mouse wheel up/down zoom out/zoom in on the X-axis 

Ctrl + mouse wheel up/down zoom out/zoom in on the Y-axis 

Ctrl + Alt + mouse wheel 
up/down 

zoom out/zoom in on the active Y-axis if the data is visualized on top of 
each other 

right mouse button + move 
mouse 

Move the curve window in both axis directions 
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Shift + right mouse button zoom out the X-axis 

Shift + left mouse button zoom in the X-axis 

Ctrl + right mouse button zoom out the Y-axis 

Ctrl + left mouse button zoom in the Y-axis 

left mouse button + move 
mouse 

zoom in the X-axis to the marked area 

 

9.3 Toolbar 

On the tool bar are the following functions available for manipulating the visualization of the curve window: 
 
Rezoom 
 
The axis of the chosen curve window are set that the whole data is visible. 
 

 
 

Zoom on diagnostic attributes 
 
The axis of the chosen curve window are set that the diagnosis attributes of the selected drive element are 

shown. In the menu Options on the tab Visualization → Diagnosis attributes the behavior of the zooming 
can be adjusted. The following options are available: 

• no zoom on diagnostic attributes Zoom on diagnostic attributes has the same functionality as Rezoom 

• zoom left and right on diagnostic attribute The X axis will be set that the selected diagnostic attribute is 
in the center of the curve window 

• zoom from 0 to diagnostic attribute The X axis will be set that the curve window is shown from 0 to the 
selected diagnostic attribute 
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Last zoom position 
 
The curve window will be reset to the last used axis positions. 
 
Measurement Cursor 
 
Places a measurement cursor for measuring distances, frequencies and orders in a chosen curve window. 
Also see Measurement Cursor.  
 
Harmonic Cursor 
 
Places an harmonic cursor on the chosen curve window. This cursor is only usable for spectra. Also see 
Harmonic Cursor. 
 
Sideband Cursor 
 
Places a sideband cursor on the chosen curve window. This cursor is only usable for spectra. Also see 
Sideband Cursor. 
 
Marking Cursor 
 
Places a marking cursor in the chosen curve window. Also see Marking Cursor.  
 
Print Preview / Normal View 
 
All curve window are visualized as in the options defined color scheme. The following default color 
schemes are available: 
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Clipboard 
 

Copy the selected curve window to the clipboard. In the options on the tab Visualization → Clipboard, it can 
be chosen whether the print view should be used for copying. If this option is deactivated, the currently 
activated color scheme is used. The data is copied as vector graphic into the clipboard to have the optimal 
resolution on a printed document. It is advised to use a printer driver that is based on PCL5e since this 
driver can better handle large vector graphics. 
 
Print 
 
The chosen curve window is printed with the print view color schema via the default printer dialog. It is 
advised to use a printer driver that is based on PCL5e since this driver can better handle large vector 
graphics. 
 
 



Peakanalyzer Manager Manual 
 
 
 

 

98 / 108 

Activate 2D View 
 
Changes the view to 2D-View. The data for the 3D-View will remain in the background to allow a fast switch 
between these two views. 
 
In a row 
 
In all curve windows the shown data will be visualized in a row with one Y-Axis. 
 

 
 
On top of each other 
 
In all curve windows the shown data will be visualized on top of each other with multiple Y-Axis. 
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Legend on/off 
 
The legend can be faded in or out for the selected data. The following pictures show the visualization with 
and without legend. 
 

 
 
Educed spectra 
 
For frequency and order spectra the spectra of vibration acceleration, vibration velocity and vibration 
distortion are visualized on top of each other. If vibration acceleration data is saved, the vibration velocity 
and vibration distortion spectra are educed by integrating the vibration acceleration spectra. If vibration 
distortion data is saved, the vibration velocity and vibration acceleration spectra are educed by 
differentiating the vibration distortion spectra. For order spectra the average speed during the 
measurement time is used to calculate the other spectra.  
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Activate 3D View 
 
Changes the view to the 3D-View. In this view, the spectrogram or waterfall for data of one sensor can be 
displayed. The sensor data with a check in the data tree view will be displayed.  
 
Spectrogram 
 
Shows the spectrogram of the data that are selected for the 3D-View. 
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Waterfall 
 
Shows the waterfall of the data that are selected for the 3D-View. 
 

 
 
Spectra of vibration acceleration 
 
The spectra of vibration acceleration are used for the 3D-View. If the vibration distortion spectra are saved 
the vibration acceleration spectra are educed by differentiating the vibration distortion spectra two times. 
For order spectra the average speed during the measurement time is used to calculate the other spectra. 
 
Spectra of vibration velocity 
 
The spectra of vibration velocity are used for the 3D-View. If the vibration acceleration spectra are saved 
the vibration velocity spectra are educed by integrating the vibration acceleration spectra one time. If the 
vibration distortion spectra are saved the vibration velocity spectra are educed by differentiating the 
vibration distortion spectra one time. For order spectra the average speed during the measurement time is 
used to calculate the other spectra. 
 
Spectra of vibration distortion 
 
The spectra of vibration distortion are used for the 3D-View. If the vibration acceleration spectra are saved 
the vibration distortion spectra are educed by integrating the vibration acceleration spectra two times. For 
order spectra the average speed during the measurement time is used to calculate the other spectra. 
 
Trend on/off 
 
An additional trend for a configurable interval can be faded in for data like process factors, characteristic 
values or diagnostic attributes. 
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Thresholds on/off 
 
If the currently selected data has configured alarm or warn thresholds, they can be faded in or out. This 
option is only available for process factors, characteristic values and diagnostic attributes.  
 

 
 
Diagnosis Range on/off 
 
If a selected data set (process factor or speed) is configured as diagnosis condition, the range can be 
faded in or out. 
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9.4 Cursor 

9.4.1 Measurement Cursor 

The measurement cursor has functionalities to measure relevant quantities of machine diagnostic and 
signal theory. It consist of two separate cursor that can be moved independently of each other. The 
distance of the cursors can be fixed to move both cursors when one is moved.  
 

 
 
  
The following information are displayed in the cursor overview on the right side bar: 

• X- and Y-Coordinate of the cursor positions 

• distance of both cursor positions on the X-axis (dX) 

• inverted distance of both cursor positions on the X-axis (1 / dX), e.g. to measure a frequency in a time 
signal 

• approximate r.m.s. of vibration velocity (vEff) at the cursor positions. In order spectra of vibration 
acceleration the average speed during the measurement is used to calculate the vibration velocity. 

 
The measurement cursor can be completely controlled with the mouse by positioning the cursor via Drag & 
Drop. It is also possible to control the measurement cursor with the keyboard. The following keys are 
available: 

Key Action 

Cursor left the first measurement cursor is moved one sample to the left 

Cursor right the first measurement cursor is moved one sample to the right 

Ctrl + Cursor left the second measurement cursor is moved one sample to the left 

Ctrl + Cursor right the second measurement cursor is moved one sample to the right 

Shift + Cursor left both measurement cursor are moved one sample to the left 

Shift + Cursor right both measurement cursor are moved one sample to the right 
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9.4.2 Harmonic Cursor 

The harmonic cursor is a special measurement cursor to determine harmonic distances in spectra. The 
harmonic cursors are distributed over the whole spectrum. If the harmonic distance is made smaller or 
bigger, the number of harmonic cursors will be automatically adopted.  
 

 
 
The following information are displayed in the cursor overview and can be manipulated on the right side 
bar: 

• harmonic distance between two single harmonic cursor 

• offset to search for harmonic families in the spectrum 

• fixing the cursor number that controls the position of the whole harmonic cursor 

• fixing the number of entitled cursor 

• a text that is written on all entitled cursor 
 
The harmonic cursor can be completely controlled with the mouse by positioning the cursor via Drag & 
Drop. It is also possible to control the harmonic cursor with the keyboard. The following keys are available: 

Key Action 

Cursor left the harmonic distance is reduced by one sample 

Cursor right the harmonic distance is increased by one sample 

Ctrl + Cursor left the second measurement cursor is moved on sample to the left 

Ctrl + Cursor right the second measurement cursor is moved on sample to the right 
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9.4.3 Sideband Cursor 

The harmonic cursor is a special measurement cursor to determine harmonic distances in spectra. The 
harmonic cursors are distributed over the whole spectrum. If the harmonic distance is made smaller or 
bigger, the number of harmonic cursors will be automatically adopted.  
 

 
 
The following information are displayed in the cursor overview and can be manipulated on the right side 
bar: 

• position of the main cursor on the X-Axis 

• distance of the sideband cursor to each other 

• fixing the number of displayed sideband cursor 

• a text that is written on the main cursor 

• a text that is written on all entitled sideband cursor 
 
The sideband cursor can be completely controlled with the mouse by positioning the cursor via Drag & 
Drop. It is also possible to control the sideband cursor with the keyboard. The following keys are available: 

Key Action 

Cursor left the position of the main cursor and all sideband cursor is moved one sample to 
the left 

Cursor right the position of the main cursor and all sideband cursor is moved one sample to 
the right 

Ctrl + Cursor left the distance of the sideband to each other is decreased by one sample 

Ctrl + Cursor right the distance of the sideband to each other is increased by one sample 
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9.4.4 Marking Cursor 

The marked cursor is a simple cursor that allows to mark certain peaks or points in one data set. 
 

 
 
The following information are displayed in the cursor overview and can be manipulated on the right side 
bar: 

• position of the cursor on the X-Axis 

• a text that is displayed at the marked cursor 
 
The marked cursor can be completely controlled with the mouse by positioning the cursor via Drag & Drop. 
It is also possible to control the marked cursor with the keyboard. The following keys are available: 

Key Action 

Cursor left the position of the marked cursor is moved one sample to the left 

Cursor right the position of the marked cursor is moved one sample to the right 
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9.5 Filter Settings 

By adjusting the filter settings the visible data in the data selection tree can be individually adopted. 
 

 
 
The following filter options are available: 
 
Date 
Allows to reduce the displayed data to the set time frame. By default the last 3 months are displayed. 
 
Diagnosis range 
Allows to reduce the displayed data to a configured diagnosis range where an analysis has taken place. By 
default all diagnosis ranges are displayed. 
 
Speed range 
Allows to reduce the displayed data to a certain speed range.  
 
Process range 
Allows to reduce the displayed data to a certain process range. The information for the process channels 
are read from the configuration of the Peakanlyzer. 

9.6 Selection of Diagnostic Attributes 

The diagnostic attributes can be faded in for each configured drive element. The drive element and 
corresponding damage pattern can be selected in the right side bar. This functionality is only available if a 
spectrum was selected in the data selection tree. In the following picture is a local tooth damage of a gear 
box displayed.  
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9.7 Trend Visualisation 

A trend can be displayed additionally for measured data like process factors, characteristic values or 
diagnostic attributes. This is useful to observe the long-term evolution of the signal. The Trend can be 
activated and configured on the right side bar. The interval for the averaging can be set as a parameter. 
The visualization of the trend is only possible if one of the above stated data types is displayed. The 
following picture shows a trend with an interval of 5 days additionally to the measured process factor. 
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